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Important safety information

This manual contains information and warnings that must be followed by the user for safe operation and to keep the productin a
safe condition.

To safely perform service on this product, see the Service safety summary that follows the General safety summary.

General safety summary

Use the product only as specified. Review the following safety precautions to avoid injury and prevent damage to this product or
any products connected to it. Carefully read all instructions. Retain these instructions for future reference.

This product shall be used in accordance with local and national codes.

For correct and safe operation of the product, it is essential that you follow generally accepted safety procedures in addition to
the safety precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover for repair, maintenance, or adjustment.
Before use, always check the product with a known source to be sure it is operating correctly.

This product is not intended for detection of hazardous voltages.

Use personal protective equipment to prevent shock and arc blast injury where hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the responsibility of the assembler of the system.

To avoid fire or personal injury

Use proper power cord. Use only the power cord specified for this product and certified for the country of use. Do not use the
provided power cord for other products.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric shock, the
grounding conductor must be connected to earth ground. Before making connections to the input or output terminals of the
product, ensure that the product is properly grounded. Do not disable the power cord grounding connection.

Power disconnect. The power cord disconnects the product from the power source. See instructions for the location. Do not
position the equipment so that it is difficult to operate the power cord; it must remain accessible to the user at all times to allow for
quick disconnection if needed.

Connect and disconnect properly. Do not connect or disconnect probes or test leads while they are connected to a voltage
source. Use only insulated voltage probes, test leads, and adapters supplied with the product, or indicated by Tektronix to be
suitable for the product.

Observe all terminal ratings. To avoid fire or shock hazard, observe all rating and markings on the product. Consult the product
manual for further ratings information before making connections to the product. Do not exceed the Measurement Category
(CAT) rating and voltage or current rating of the lowest rated individual component of a product, probe, or accessory. Use caution
when using 1:1 test leads because the probe tip voltage is directly transmitted to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.
Do not float the common terminal above the rated voltage for that terminal.

Do not operate without covers. Do not operate this product with covers or panels removed, or with the case open. Hazardous
voltage exposure is possible.
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Important safety information

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by qualified
service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates incorrectly. If in doubt about safety of the
product, turn it off and disconnect the power cord. Clearly mark the product to prevent its further operation.

Before use, inspect voltage probes, test leads, and accessories for mechanical damage and replace when damaged. Do not use
probes or test leads if they are damaged, if there is exposed metal, or if a wear indicator shows.

Examine the exterior of the product before you use it. Look for cracks or missing pieces.
Use only specified replacement parts.
Use proper fuse. Use only the fuse type and rating specified for this product.

Do not operate in wet/damp conditions. Be aware that condensation may occur if a unit is moved from a cold to a warm
environment.

Do not operate in an explosive atmosphere.
Keep product surfaces clean and dry. Remove the input signals before you clean the product.

Provide proper ventilation. Refer to the installation instructions in the manual for details on installing the product so it has
proper ventilation.

Slots and openings are provided for ventilation and should never be covered or otherwise obstructed. Do not push objects into
any of the openings.

Provide a safe working environment. Always place the product in a location convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or prolonged keyboard or pointer use may
result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an ergonomics professional to avoid stress injuries.

Use only the Tektronix rackmount hardware specified for this product.

Probes and test leads

Before connecting probes or test leads, connect the power cord from the power connector to a properly grounded power outlet.
Keep fingers behind the protective barrier, protective finger guard, or tactile indicator on the probes.

Remove all probes, test leads and accessories that are not in use.

Use only correct Measurement Category (CAT), voltage, temperature, altitude, and amperage rated probes, test leads, and
adapters for any measurement.
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Important safety information

Beware of high voltages. Understand the voltage ratings for the probe you are using and do not exceed those ratings. Two
ratings are important to know and understand:

= The maximum measurement voltage from the probe tip to the probe reference lead
= The maximum floating voltage from the probe reference lead to earth ground

These two voltage ratings depend on the probe and your application. Refer to the Specifications section of the manual for more
information.

WARNING. To prevent electrical shock, do not exceed the maximum measurement or maximum floating voltage for the
A oscilloscope input BNC connector, probe tip, or probe reference lead.

Connect and disconnect properly. Connect the probe output to the measurement product before connecting the probe to the
circuit under test. Connect the probe reference lead to the circuit under test before connecting the probe input. Disconnect the
probe input and the probe reference lead from the circuit under test before disconnecting the probe from the measurement
product.

Connect and disconnect properly. De-energize the circuit under test before connecting or disconnecting the current probe.
Connect the probe reference lead to earth ground only.
Do not connect a current probe to any wire that carries voltages or frequencies above the current probe voltage rating.

Inspect the probe and accessories. Before each use, inspect probe and accessories for damage (cuts, tears, or defects in the
probe body, accessories, or cable jacket). Do not use if damaged.

Ground-referenced oscilloscope use. Do not float the reference lead of this probe when using with ground-referenced
oscilloscopes. The reference lead must be connected to earth potential (0 V).

Service safety summary

The Service safety summary section contains additional information required to safely perform service on the product. Only
qualified personnel should perform service procedures. Read this Service safety summary and the General safety summary
before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this product unless another person capable of rendering
first aid and resuscitation is present.

Disconnect power. To avoid electric shock, switch off the product power and disconnect the power cord from the mains power
before removing any covers or panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist in this product. Disconnect power, remove
battery (if applicable), and disconnect test leads before removing protective panels, soldering, or replacing components.

Verify safety after repair. Always recheck ground continuity and mains dielectric strength after performing a repair.
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Important safety information

Terms in the manual

These terms may appear in this manual:

2 WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

2 CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Terms on the product

These terms may appear on the product:
= DANGER indicates an injury hazard immediately accessible as you read the marking.
= WARNING indicates an injury hazard not immediately accessible as you read the marking.

= CAUTION indicates a hazard to property including the product.

Symbols on the product

When this symbol is marked on the product, be sure to consult the manual to find out the nature of the potential
hazards and any actions which have to be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

The following symbols may appear on the product;

A © +» (h £

; Functional
Regﬁﬂgﬂum F}?;ﬁ;"%?,;?#;d Chassis Ground Standby Earth Terminal
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Preface

This manual provides product safety and compliance information, describes how to connect and power on the oscilloscope, and
introduces the basic instrument features, controls, and operations. See the product Help file for more detailed information.

Key features

Welcome to the 3 Series MDO. The 3 Series MDO Oscilloscopes (MDO32 and MDO34) are 2- and 4-channel oscilloscopes,
enabling you to efficiently and cost-effectively perform mixed domain debugging.

= Adedicated RF input channel for frequency domain measurements
= Bandwidths from 100 MHz to 1 GHz

m  2-and 4-channels for time domain measurements

= Sixteen-channel digital input option

= Large 11.6" HD (1920 x 1080 pixel) capacitive touchscreen display
= Userinterface optimized for touchscreen use

= Sample rates of 2.5 GS/s on all analog channels (5 GS/s on 1 or 2 channels for the MDO34 or MDO32 with the 1 GHz
option)

= 10 M points record length on all channels

= Maximum waveform capture rate: 280,000 waveforms/second, with FastAcq: >50,000 waveforms/second with normal
operation

= Advanced triggering and analysis: 12C, SPI, USB 2.0, CAN, CAN FD, LIN, FlexRay, RS-232, RS-422, RS-485, UART, 12S,
Left Justified (LJ), Right Justified (RJ), TDM, MIL-STD-1553, ARINC429 (with the appropriate option), and Parallel

= Power analysis (optional)
= Arbitrary function generator and 16 digital channels (optional)

= Digital voltmeter and trigger frequency counter free with product registration
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Preface

Related documents

viii

Use the related documents for more information on instrument functions, how to remotely program or operate the instrument,
understand theory of operation, replace suspected modules, and other tasks.

MDO34, MDO32 documents

To learn about

Use this document

How to use instrument
functions

3 Series MDO (MDO34, MDO32) Installation and Safety Manual (This document, Tektronix part
number 071-3608-xx); standard accessory with the instrument. Single document with English,
Japanese, and Simplified Chinese languages.

3 Series MDO Help (Printable version of the instrument Help that contains context-sensitive
descriptions of all instrument functions; available at www.tek.com/downloads)

How to remotely control the
instrument

3 Series MDO Programmer Manual (Tektronix part number 077-1498-xx; available at
www.tek.com/downloads)

Instrument specifications and
procedures to verify the
instrument meets
specifications

3 Series MDO (MDO34, MDO32) Specifications and Performance Verification Technical
Reference (Tektronix part number 077-1499-xx; available at www.tek.com/downloads)

Instrument theory of operation,
troubleshooting, disassembly,
and replaceable parts

3 Series MDO (MDO34, MDO32) Service Manual (Tektronix part number 077-1500-xx;
available at www.tek.com/downloads)

Installing the instrument in a

rack

RM3 Rack Mount Kit Instructions (Tektronix part number 071-3609-xx; available at
www.tek.com/downloads)
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Installing your instrument

Check shipped accessories

Make sure that you received everything you ordered. If anything is missing, contact Tektronix Customer Support. In North
America, call 1-800-833-9200. Worldwide, visit www.tek.com to find contacts in your area.

Check the packing list that came with your instrument to verify that you have received all standard accessories and ordered
items. If you purchased factory options, tap Help > About to confirm that the option(s) are listed in the Installed Options table.

Standard accessories

Item Quantity Tektronix part number
3 Series MDO (MDO34, MDO32) Installation and Safety Manual 1 071-3608-xx
Passive Voltage Probe, depends on instrument bandwidth One per analog channel

(1 GHz bandwidth) TPP1000

(350 MHz and 500 MHz) TPP0500B

(100 MHz and 200 MHz bandwidth) TPP0250
Accessory bag 1 016-2144-xx
Power cord 1 Depends on region
Calibration certificate 1 N/A
OpenChoice® Desktop Software (available for download from www.tek.com/
software/downloads.)

Safely rotate the handle

Use the correct process to eliminate the chance of pinching your thumb or rear-panel-connected cables while rotating the handle.

CAUTION. Hold the top of the handle to rotate the handle on the instrument. Do not hold the handle from the sides and rotate, as
A this can pinch the base of your thumb between the handle and the case.

If you have routed any cables between the handle and the case, be careful when rotating the handle so that you do not pinch the
cables.

344008

MDO32, MDO34 Installation and Safety Manual 1



Installing your instrument

Operating requirements

Use the oscilloscope within the required operating temperature, power, altitude, and signal input voltage ranges to provide the
most accurate measurements and safe instrument operation.

Environment requirements

Characteristic Description
Operating temperature -10 °C to +55 °C (+14 °F to +131 °F)

For proper cooling, keep the sides and rear of the instrument clear of obstructions for
2 inches (51 mm).

Operating humidity 5% to 90% relative humidity (% RH) up to +40 °C (+104 °F), Noncondensing.

5% to 60% RH above +40 °C up to +55 °C (+104 °F to +131 °F), Noncondensing.
Operating altitude Up to 3000 meters (9842 feet)

Power requirements

Characteristic Description
Power source voltage 100 V - 240 V¢ rus, £10%, single phase
Power source frequency 50/60 Hz, 100-240 V

400 Hz £10% at 100 to 132V

Power consumption 130 W maximum

Input signal requirements

Keep the input signals within allowed limits to ensure the most accurate measurements and prevent damage to the analog and
digital probes or instrument.

Make sure that input signals are within the following requirements.
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Installing your instrument

Table 1: Maximum analog input

Input Description

Analog input channels, 1 M Q setting, maximum | 300 Vrys
input voltage at BNC
Measurement Category Il

De-rate at 20 dB/decade between 4.5 MHz and 45 MHz, De-rate 14 db
between 45 MHz and 450 MHz. Above 450 MHz, 5 VRrys.

Analog input channels, 50 Q setting, maximum 5 Vrus with a peak at +20 V. (DF < 6.25%).
input voltage at BNC

RF input maximum input voltage Average Continuous Power: +20 dBm (0.1 W)

DC maximum before damage: +40 VDC

Max no damage +33 dBm (2 W) CW

Peak Pulse Power: +45 dBm (32 W)

Peak Pulse Power defined as <10 s pulse width, <1% duty cycle, and
reference level of = +10 dBm

Table 2: Maximum input with a P6316 Digital Probe

Input Description

Threshold Accuracy £(100 mV + 3% of threshold setting after calibration)
Threshold Range +25Vto-15V

Maximum nondestructive input signal to probe +30Vto-20V

Minimum signal swing 500 MVpeak-to-peak

Input resistance 101 kQ

Input capacitance 8.0 pF typical

Pollution Degree 2, indoor use only

Humidity 5% to 95% relative humidity

MDO32, MDO34 Installation and Safety Manual 3



Installing your instrument

Secure (lock) the oscilloscope

Lock an oscilloscope to a test bench or equipment rack to prevent property loss.

Attach a standard laptop security lock to the rear panel of the oscilloscope, to secure the oscilloscope to a workbench, rack, or

other location.

100-240 V
50/60 Hz

115V, 400 Hz e
130 W Max [E s Mfr. Compliance Contact
osc Tektronix, Inc.
Patents associated with this product, PO Box 500, MS 19-045
if any, can be found at: @ X ﬂ O @. Beaverton, OR 97077, USA
— c us www.tek.com

www.patentlabel.com/tektronix

AFG Out AUX Out LAN 10/100 USB 2.0 USB 2.0

© O i =

3608-003
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Installing your instrument

Powering the oscilloscope

Use this procedure to connect the oscilloscope to line power and power on and off the oscilloscope. Always connect the
oscilloscope to AC power using the power cord that shipped with the instrument.

Prerequisite: Use the AC power cord that shipped with your oscilloscope.

1. Connect the supplied power cord to the oscilloscope power connector.

[l

0 Qg
0

00 o

ca

a

flo oo O Ol

O

[ =
PR =
i g

3608-001

Figure 1: Power cord connector and power standby switch

2. Connect the power cord to an appropriate AC mains source.

Power is supplied to the power supply and some other boards whenever the AC power cord is connected to a live mains
circuit, putting the instrument in standby mode.

3. Push the front panel power button to power the instrument on and off.
The power button color indicates instrument power states:

Unlit — no AC power applied
Yellow — standby mode
Blue — powered on

4. To completely remove power from the instrument, disconnect the power cord.
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Installing your instrument

Check that the oscilloscope passes power-on self tests
Power-on self tests verify that all oscilloscope modules are working correctly after power up.

1. Power on the oscilloscope and wait until the oscilloscope screen appears.
2. Select Utility > Self Test from the top-edge Menu bar to open the Self Test configuration menu.

3. Check that the status of all power-on self tests are Passed.

If one or more power-on self tests shows Failed:

a. Power cycle the oscilloscope.

b. Tap Utility > Self Test. If one or more power-on self tests still shows Failed, contact Tektronix Customer Support.

Connecting probes

Probes and cables connect the oscilloscope to your device under test (DUT). Use a probe that best matches your signal
measurement needs.

3608-002

Figure 2: Connecting probes to the instrument

1. Tektronix Versatile Probe Interface (TekVPI)

These probes support two-way communication with the oscilloscope through on-screen menus and remotely through
programmable support. The remote control is useful in applications like ATE where you want the system to set probe
parameters.

2. Tektronix Versatile Probe Interface (TekVPI) for Passive Probes

These probes build upon the functionality of the TekVPI interface. Each probe is matched with its corresponding
oscilloscope channel, allowing the oscilloscope to optimize the signal input path. This provides AC compensation across the
frequency band.
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Installing your instrument

3. TPA-BNC Adapter

The TPA-BNC Adapter allows you to use TEKPROBE Il probe capabilities, such as providing probe power and passing
scaling and unit information to the oscilloscope.

4. BNC Interfaces

Some of these use TEKPROBE capabilities to pass the waveform signal and scaling to the oscilloscope. Some only pass
the signal and there is no other communication.

5. Logic Probe Interface
The P6316 probe provides 16 channels of digital (logical one or zero) information.
6. The TPA-N-VPI Adapter allows you to use TekVPI probes with the RF input.

Connect TPP0250, TPP0500B, TPP1000, TekVPI+, TekVPI, or other supported Tektronix analog probes by pushing them into
an input connector. The probe base latch locks with a 'click' when the probe is fully seated.

TekVPI probes automatically set the channel input parameters for that probe (bandwidth, attenuation, termination, and so on). If
a probe has a Menu button, push that button to open an on-screen configuration menu. Follow instructions provided with active
probes to set their parameters (auto zero, degauss, and so on).

Connect a BNC probe or cable by pushing it onto a channel BNC bayonet connector and turn the lock mechanism clockwise until
it locks.

For more information on the many probes available for use with 3 Series MDO oscilloscopes, visit the Oscilloscope Probe and
Accessory Selector Tool on the Tektronix website at www.tektronix.com.

NOTE. Connecting a probe does not automatically enable that channel (make it active). Use the instrument controls or
programmatic interface to turn on a channel and open its configuration menu to verify or change probe or cable settings
(bandwidth, attenuation, termination and so on).

Rackmount information

The optional RM3 Rackmount Kit lets you install the oscilloscope in standard equipment racks. The rack mount requires six rack
units (6U) of space to install.

Contact Tektronix Customer Support to purchase the rackmount kit option RM3. Follow the instructions that come with the
rackmount kit (RM3 Rackmount Kit Instructions, Tektronix part number 071-3609-xx).

Make sure to allow at least two inches of clearance on the sides for air ventilation and on the back for any cables you attach to
the rear panel.

MDO32, MDO34 Installation and Safety Manual 7



Installing your instrument

Remote access from a Web browser

You can remotely access your network-connected instrument from a Web browser to display the instrument user interface on a
PC.

This procedure describes how to remotely access the Ul controls and screen for the instrument.
Prerequisites:

= The oscilloscope must be connected to, and accessible from, the network to which the PC is connected. See Connect to a
network (LAN) on page 34

= Determine the IP address of the oscilloscope that you want to access. To determine the oscilloscope's IP address, select
Utility > 10 in the oscilloscope menu bar and view the network settings in the LAN panel.

1. Open a Web browser on a PC connected to the same network as the oscilloscope.

2. Enter just the oscilloscope IP address on the URL line of the browser and press Enter. For example: 135.62.88.157. The
browser searches for and opens the Web page for the oscilloscope.

Connect the oscilloscope to a PC using a USB cable

Use a USB cable to connect the oscilloscope directly to a PC for remote instrument control.
On the oscilloscope, select Utility > 1/0 from the menu bar.

Tap USB Device Port.

Confirm that the USB Device Port control is On (default setting).

Connect a USB cable from the PC to the USB Device port on the rear of the instrument.

o M 0 Db =

If using the USB connection to remotely control the oscilloscope using GPIB commands, set the GPIB Talk/Listen Address
for your configuration (0 - 30).
Cleaning

Use a dry, soft cotton cloth to clean the outside of the unit. If any dirt remains, use a cloth or swab dipped in a 75% isopropyl

alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do not use any liquid cleaning agents or
chemicals that could damage the touchscreen, case, controls, markings or labels, or possibly infiltrate the case.

8 MDO32, MDO34 Installation and Safety Manual



Getting acquainted with your instrument

The following content provides a high-level description of the instrument controls and user interface.

Refer to the instrument help for detailed information on using the controls and user interface to display waveforms and take
measurements.

Front panel controls and connectors

The front panel controls provide direct access to key instrument settings such as vertical, horizontal, trigger, and cursors. The
connectors are where you input signals with probes or cables or insert USB devices.

Tektronix

Figure 3: 3 Series MDO controls

MDO32, MDO34 Installation and Safety Manual 9



Getting acquainted with your instrument

10

1.

Acquisition and Cursors controls:

! |

& K36

3514011

Run/Stop starts and stops waveform acquisition. The button color indicates the acquisition status (green = running and
acquiring; red = stopped). When stopped, the oscilloscope shows waveforms from the last completed acquisition. The
Run/Stop button on the screen also shows the acquisition status.

Cursors button turns cursors on or off. Use the Multipurpose knobs to move the cursors. Double-tap the cursor
readouts or on a cursor bar (line) to open the configuration menu to set cursor types and functionality.

Fast Acq™ enables or disables the fast acquisition mode. FastAcq provides high-speed waveform capture that
reduces the dead time between waveform acquisitions, enabling the capture and display of transient events such as
glitches and runt pulses. It is helpful in finding elusive signal anomalies. Fast acquisition mode can also display
waveform phenomena at an intensity that reflects their rate of occurrence.

Single/Seq enables making a single waveform acquisition, or a specified number of acquisitions (as set in the
Acquisition configuration menu). Pushing Single/Seq turns off Run/Stop mode and takes a single acquisition. The
button color indicates the acquisition status (quick green flash = single acquisition acquired; solid green = waiting for
trigger event). Pushing Single/Seq again takes another single acquisition.

High Res mode calculates the average of all the samples for each acquisition interval. High Res provides a higher-
resolution, lower-bandwidth waveform.

Clear deletes the current acquisitions and measurement values from memory.

Multipurpose knobs:

Multipurpose knobs (A, B) Multipurpose knobs A and B move cursors, adjust the zoom, and set parameter values in
configuration menu input fields. Selecting a menu field that can use a Multipurpose knob assigns the indicated knob to
change the value in that input field. The ring around each knob lights when you can use that knob to do an action.

Push a Multipurpose knob to enable the Fine mode for making smaller increment changes. Push the knob again to exit
Fine mode.

NOTE. If you have a mouse aftached, pressing the mouse wheel toggles between Coarse and Fine adjustments.
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Getting acquainted with your instrument

3. Trigger controls:

TRIGGER

1

Level

DDQ

3514-012

= Force forces a trigger event at a random point in the waveform and captures the acquisition.

= Level sets the amplitude level that the signal must pass through to be considered a valid transition. The color of the
Level knob indicates the trigger source except for dual-level triggers. The Level knob is disabled when the trigger type
requires two level settings or other trigger qualifiers (set from the Trigger configuration menu). Push the knob to set the
threshold level to 50% of the peak-to-peak amplitude range of the signal.

= Slope sets the signal transition direction to detect for a trigger (low to high, high to low, or either direction). Push the
button to cycle through the selections. The Slope button is disabled when the trigger type requires other slope
qualifiers (set from the Trigger configuration menu).

= Mode sets how the instrument behaves in the absence or presence of a trigger event:

= Auto trigger mode enables the instrument to acquire and display a waveform whether or not a trigger event
occurs. If a trigger event occurs, the instrument displays a stable waveform. If a trigger event does not occur, the
instrument forces a trigger event and acquisition and displays an unstable waveform.

= Normal trigger mode sets the instrument to acquire and display a waveform only when there is a valid trigger
event. If no trigger occurs, the last waveform record acquired remains on the display. If no last waveform exists,
no waveform is displayed.

MDO32, MDO34 Installation and Safety Manual 1"



Getting acquainted with your instrument

12

4,

Vertical controls:

VERTICAL

Position

O

() to Center

Scale

O

B Fine

agge
goaeo

3608-011

= Position moves the selected waveform up or down on the screen. The color of the Position knob indicates which
waveform the knob is controlling. Push the knob to center the waveform handle on the display.

= Scale sets the amplitude units per vertical graticule division of the selected waveform. The scale values are shown on
the waveform badge. The color of the Scale knob indicates which waveform the knob is controlling.

= Channel buttons turn on (display), select, or turn off a channel, as follows:

If the channel is not displayed, pushing a Channel button turns on that channel in the Waveform view.
If the channel is on the screen and is not selected, pushing that channel's button selects that channel.

If the channel is on the screen and is also selected, pushing that channel's button turns that channel off (removes
it from Waveform view).

= The Math button adds or selects a Math waveform on the Waveform view, as follows:

If no Math waveform exists, pushing the Math button adds a Math waveform to the Waveform view and opens the
Math configuration menu.

If a Math waveform is displayed but not selected, pushing the button selects the Math waveform.

If a Math waveform is displayed and selected, pushing the button turns off the Math waveform (removes it from
Waveform view). Push the button again to display the waveform.

= The Ref button adds or selects a Reference (saved) waveform on the Waveform view, as follows:

If no Reference waveform exists, pushing the Ref button opens the Browse Waveform Files configuration menu.
Navigate to and select a waveform file (*.isf) and tap Recall to load and display the reference waveform.

If only one Reference waveform is displayed, pushing the button turns off the Reference waveform (removes it
from the Waveform View). Push the button again to display the waveform.

If two or more Reference waveforms are displayed, pushing the button cycles through selecting each Reference
waveform.

= The Bus button adds or selects a bus waveform on the Waveform view, as follows:

If no Bus waveform exists, pushing the Bus button adds a Bus waveform to the Waveform view and opens the
Bus configuration menu.

If only one Bus waveform is displayed, pushing the button turns off the Bus waveform (removes it from Waveform
view).

If two Bus waveforms are displayed, pushing the button cycles through selecting each Bus waveform.
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= The RF button adds the RF waveform on the Waveform view and switches from the time domain to the frequency
domain. All time domain waveforms are turned off and the spectrum analyzer is turned on. When you switch back to
the time domain, the time domain waveforms are restored.

= The Digital button adds or selects a digital waveform on the Waveform view
= |fthe digital channels are not displayed, pushing a Digital button turns on the channels in the Waveform view.
= [fthe digital channels are on the screen, but not selected, pushing the Digital button selects the digital channels.

= [fthe digital channels are on the screen and are also selected, pushing the Digital button turns the digital
channels off (removes them from Waveform view).

5. Horizontal controls:

HORIZONTAL

Position Scale

) to center

3608-012

= Position moves the waveform from side to side on the screen (changing the trigger point position in the waveform
record). Push the knob to center the trigger event to the center of the graticule.

= Scale sets the time per major horizontal graticule division and samples/second parameters for the oscilloscope. Scale
applies to all waveforms.

6. Miscellaneous controls:

= Touch Off turns touchscreen capability off. The Touch Off button is lighted when the touchscreen is turned off.

= Save is a one-push save operation that uses the current File > Save As settings to save screen shots (including open
menus and dialog boxes), waveform files, instrument settings, and so on, as follows:

= [faFile > Save or File > Save As operation has occurred since the last instrument startup, pushing Save saves
the file types to the location last set in the Save As configuration menu.

= [fnofile save operation has occurred since the last instrument startup, pushing Save opens the Save As
configuration menu. Select a tab to select the type of file to save (Screen Capture, Waveform, and so on), set any
associated parameters, and where to save it, and select OK. The specified file or files are saved. The next time
you push Save, the same type of files are saved.

= Screen Captures capture the entire screen, including displayed configuration menus and dialog boxes.

= Default Setup restores the oscilloscope settings (horizontal, vertical, scale, position, and so on) to the default settings.
Default Setup does not change items found in the User Preferences menu.

= Autoset automatically displays a stable waveform.
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7. Ground and Probe Compensation connectors:

Wrist Band

Probe Tip

3608014

= The Ground and Probe Compensation connectors are located at the lower right side of the instrument, near the front
panel. The Ground connector (the small hole in the case) provides an electrically grounded (through a resistor)
connection point to attach an anti-static wrist strap to reduce electrostatic damage (ESD) while you handle or probe the
DUT.

= The Probe Compensation connections provide a ground connector (upper tab) and 1 kHz square wave source (lower
tab) for adjusting the high-frequency response of a passive probe (probe compensation). The oscilloscope uses this
signal to automatically compensate supported probes, including the ones that ship with the product. See Compensate
TPP0250, TPP0500B, or TPP1000 probes on page 33.

8. USB Host ports (USB 2.0):

== (N
=D

3608-015

USB 2.0

=  USB ports are located at the lower right corner of the front panel and on the rear panel. Connect USB flash drives to
which you can save or recall data (such as instrument software updates, waveforms, settings, and screen captures) or
connect peripheral devices such as a mouse or keyboard.
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9. Probe connectors:

= Analog input connectors support all TekVPI+ and TekVPI measurement probes, BNC passive probes, the P6316 Logic
Probe, and BNC cables. See Connecting probes on page 6.

Rear panel connections

The rear panel connections supply power to the oscilloscope and provide connectors for network, USB devices, video, reference
signals, and the AFG output.

100-240 V
50/60 Hz
115V, 400 Hz KCC-
130 W Max [E s Mfr. Compliance Contact
osc Tektronix, Inc.
5

Patents associated with this product, PO Box 500, MS 19-045
if any, can be found at: @ X ﬂ (sp: @ Beaverton, OR 97077, USA
www.patentlabel.com/tektronix — c

©
U www.tek.com

AFG Out AUX Out LAN 10/100 USB 2.0
Device

3608-023

1. Power cord connector. Use only the power cord specified for this product and certified for the country of use.
2. AFG Out is the signal output for the optional Arbitrary Function Generator (AFG) feature.
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AUX Out generates a signal transition on a trigger event or outputs a synchronization signal from the AFG.
LAN connector (RJ-45) connects the oscilloscope to a 10/100 Base-T local area network.

USB Device port lets you connect to a PC to remotely control the oscilloscope using the USBTMC protocol.
USB Host port lets you connect a USB memory device, keyboard, or mouse.

HDMI output lets you connect an external monitor or projector to show the oscilloscope screen.

© N o o B~ »

Security lock connector lets you use a standard PC/laptop lock cable to secure the oscilloscope to a work bench or other
location.

The user interface screen

The touchscreen user interface contains waveforms, measurement readouts, and touch-based controls to access all oscilloscope
functions.

KhamnEan
EEITE @R
—

i

200 vdiv | 2.00 Vidiv
3 ™o

1 GHe 500 MH:

1. The Menu bar provides menus for typical operations including:

3608-032

= Saving, loading, and accessing files

= Setting oscilloscope display and measurement preferences
= Configuring network access

= Running self tests

= Erasing measurement and settings memory (TekSecure™)
= Loading option licenses

= Opening a Help viewer

2. The Waveform View area displays analog, digital, math, reference, and bus waveforms. The waveforms include waveform
handles (identifiers), trigger position, and level(s) indicators. See Identifying items in the time domain display on page 17.
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3. The Results Bar contains controls for displaying cursors, adding result tables to the screen, and adding measurements to
the Results bar. The controls are:

= The Cursors button displays on-screen cursors. Touch and drag or use the Multipurpose knobs to move the cursors.
Double-tap on a cursor or on the cursor readouts to open a configuration menu to set cursor types and related
functions.

= The Measure button opens a configuration menu from which to select and add up to four measurements to the Results
bar. Each measurement you add has a separate badge. Double-tap a measurement badge to open its configuration
menu.

= The Results Table button adds a Measurement, Bus, Search, and Harmonics results table to the screen. The Measure
tab displays all measurements present in the Results bar. The Bus tab displays bus decode information for displayed
bus waveforms. The Search tab displays search event information. The Harmonics tab displays harmonic
measurement results.

= The Search button lets you detect and mark a waveform where specified events occur. Tap Search to open a Search
configuration menu and set the search conditions for analog and digital channels. Search badges are added to the
Results Bar.

= The Measurement and Search badges show measurement and search results and are displayed in the Results Bar.
See Badges on page 22.

4. The Settings Bar contains System badges for setting Horizontal, Trigger, Acquisition, and Date/Time parameters; Inactive
Channel buttons to turn on channels; Math/Ref/Bus button to add math, reference, and bus waveforms to the display; and
Channel and Waveform badges that let you configure the individual waveform parameters. Tap a channel or waveform
button to add it to the screen and display a badge. Double-tap a badge to open its configuration menu. See Badges on
page 22.

5. Configuration Menus let you quickly change the parameters of the selected user interface item. You can open
configuration menus by double-tapping on badges, screen objects, or screen areas. See Configuration menus on page 27.

Identifying items in the time domain display

Each area of the user interface has a specific function that helps manage information or controls. This topic shows and describes
the key user interface elements.

2

Meas 1
tude

Ampli
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Search

Edge
Events: 9

&
Q)

Harizontal
400 ns/div
SR:2.50 GSJs
RL: 10 kpts

Trigger @  Acqguisition

Ch1 Ch 2
Math
2,00 V/div 2.00 V/div DIs \
P ma o0 :i: DVM AFG
1GHz 500 MHz
II : I: 508033
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1.

The Waveform Record View is a graphical high-level view of the overall acquisition, how much of the acquisition is on the
screen (shown in brackets), the location of key time events including the trigger event, and the current position of waveforms
Cursors.

3

If you are changing the horizontal time scale while the oscilloscope acquisition is stopped, the brackets change position to
show the part of the waveform record that is being viewed relative to the current acquisition total record length.

7l

If cursors are active on a waveform, the Waveform Record View shows the relative cursor positions as small vertical dashed
lines.

When in Zoom mode, the Waveform Record View is replaced with the Zoom Overview. See Zoom user interface elements
on page 28.

The Expansion Point icon on the waveform view shows the center point around which the waveform expands and
compresses when changing horizontal settings.

The Trigger Position Indicator shows where the trigger event occurred in the waveform record.

Tl

The Zoom icon (in upper right corner of Waveform and Plot views) toggles zoom on and off.

)::

The Trigger Level Indicator icon(s) shows the trigger level(s) on the trigger source waveform. Some trigger types require two
trigger levels.

Measurement and Search badges show measurement and search results. See Badges on page 22.

The Results Bar Handle opens or closes the Results bar to maximize waveform screen viewing when needed. To reopen
the Results bar, either tap the handle icon or swipe left from the right side of the display.
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8. The System badges show global instrument settings (Horizontal, Trigger, Acquisition, Run/Stop status, and Date/Time).
See Badges on page 22.

9. The Inactive Channel buttons add channel waveforms to the Waveform view and add an associated Channel badge to the
Settings bar.

The Add Math Ref Bus button expands allowing you to add a math, reference, or bus waveform to the Waveform view and
add an associated Waveform badge to the Settings bar.

The RF button activates the frequency domain display and adds an RF badge. Double-tap the badge to open the RF
configuration menu to configure the RF input. This button is only active if one of the RF options is enabled.

The AFG button opens the AFG configuration menu to set and enable the AFG output. This button is only present if the
AFG option is installed.

The DVM button lets you use an analog probe to take DC, AC RMS, or DC+AC RMS voltage measurements on your DUT.
Tap the button to add a DVM badge to the Results Bar and open a configuration menu. The DVM option also enables a
trigger frequency counter, accessible from the Mode & Holdoff panel in the Trigger badge menu. This button is only
present if the DVM option is installed.

10. Double-tap a badge to open its associated configuration menu. See Badges on page 22. See Configuration menus on
page 27.

If you add more Channel or Waveform badges than can fit in the waveform badge display area, tap the scroll buttons at
each end of the waveform badge area to scroll and display hidden badges.

11.  The Waveform Handles on each waveform identify the source of that waveform (Cx for channels, M for Math, Rx for
Reference waveforms, Bx for bus waveforms). The waveform handles are at the zero-volt level of the waveform by default.
The currently selected waveform handle is a solid color; unselected waveform handles are outlined.

Double-tapping a waveform handle opens the configuration menu for that waveform.

For digital channels, the waveform handle shows the channel number, with each individual digital signal labeled D0-D15
and displayed with a different color.

Double-tapping a digital waveform handle opens the digital channel configuration menu.

Dragging a digital signal handle over another handle swaps location of the signals in the waveform view. Dragging a digital
signal handle out of the group, creates a new group. A selected digital group or signal handle can be moved using the
Vertical Position control.
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Identifying items in the frequency domain display

20

This topic shows and describes each element of the frequency domain display.
To activate the frequency domain display, press the front panel RF button or tap the RF button in the display .

Each area of the user interface has a specific function that helps manage information or controls.
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1. Vertical graticule labels

3608-036

Start frequency

Reference level

Vertical scale

Center frequency

Span and resolution bandwidth

Stop frequency
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Reference marker
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Displayed trace indicators
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a. AnREF trace indicator is placed at the Reference Level.
b. A capital M appears if the maximum trace is turned on.
c. A capital A appears if the average trace is turned on.
d. A capital N appears if the normal trace is turned on.

e. The small m appears if the minimum trace is turned on.

Orange highlighting indicates the currently selected trace. In the figures the small m, which stands for the minimum
trace, is highlighted. This indicates that the minimum trace is currently selected.
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0.
10.0 dB/div

3608042
Normal trace: Each acquisition is discarded as new data is acquired.

Max hold trace: The maximum data values are accumulated over multiple acquisitions of the Normal trace.
Min hold trace: The minimum data values are accumulated over multiple acquisitions of the Normal trace.

Average trace: Data from the Normal trace is averaged over multiple acquisitions. This is true power averaging, which
occurs before the log conversion. Each power of 2 averaging reduces the displayed noise by 3 dB.
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Badges

22

Badges are rectangular icons that show waveform, measurement, and instrument settings or readouts. Badges also provide fast
access to configuration menus. The badge types are Channel, Waveform, Measurement, Search, and System.

Channel and Waveform badges

Channel and Waveform (Math, Ref, Bus) badges are shown in the Settings Bar, located along the bottom left of the screen.
Each waveform has its own badge. The badges show high-level settings for each displayed channel or waveform. Double-tap a
badge to open its configuration menu.

Ref 1
2.00 V/div 2.00 V/div 2.00 V/div 100 mV/div § Parallel
P ™MQ D -® 1.00 ps/div
1 GHz 500 MHz

4

1497-013

Most Channel and Waveform badges also have Vertical Scale buttons, shown by single-tapping the badge. Use these buttons to
increase or decrease the vertical scale setting for that waveform.

N
2.00 V/div

MQ
500 MHz

You can drag or flick Channel and Waveform badges down off the display to turn them off. Swiping back up from the bottom of
the display restores them if they were accidentally deleted.

Channel badges are listed in the channel order. For more information, double-tap the badge to open its configuration menu or
search the instrument Help.
Measurement badges

Result badges are located in the Results Bar. They show measurement or search results. The badge title also shows the
measurement source or sources. To add a Measurement badge, tap the Measure button, select a measurement, and tap Add.

Amplitude
3.04V

Double-tap a Measurement badge to open its configuration menu to change or refine settings.
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Some measurements and their badges are only available as options. For example, Power measurements are only listed in the
Add Measurement menu if the PWR option is installed.

To add statistical readouts to individual measurement badges, double-tap a measurement badge to open its configuration menu
and select Show Statistics in Badge.

You can drag or flick Measurement badges off to the right of the display to delete them. You can bring the badge back by swiping
in from the right.

Search badges

Search badges are also shown in the Results Bar, below the Measurement badges. A search badge lists the search source,
search type, and the number of search event occurrences in the current acquisition. The instrument marks the waveform where
those events occur with small down-pointing triangles along the top of the waveform graticule. Double-tap a search badge to
open its configuration menu to change or refine search settings.
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Search badges are created by tapping the Search button. Use the displayed configuration menu to set the search criteria.

Search badges have < (Previous) and > (Next) Navigation buttons that open the Zoom mode and center the waveform in the
display at the position of the previous or next search mark in the waveform record. Search badge Navigation buttons are only
usable when acquisitions are stopped.

Edge
Events: 9

< ®

You can drag or flick a Search badge to the right, off the display, to delete it. You can bring the badge back by swiping in from the
right.

Signal clipping and badges

Clipping causes inaccurate amplitude-related measurement results. Clipping also causes inaccurate amplitude values in saved
waveform files. If a math waveform is clipped, it will not affect amplitude measurements on that math waveform.

WARNING. Clipping is caused by excessive or dangerous voltages at the probe tip and/or a vertical scale setting that is not
A adequate to display the entire vertical range of the waveform. Excessive voltage at the probe tip can injure the operator and
cause damage to the probe and/or instrument.

This instrument shows a warning triangle symbol and the word Clipping in a Channel badge when a vertical clipping condition
exists. Any measurement badges associated with that channel also indicate a clipping condition.

Amplitude

V:  >204 mV

p: 204 mV

0: 0.00V

M: 204mV

m: 204 mV

# Clipping pos... |

To close the clipping message, change the vertical scale to show the entire waveform, disconnect the probe tip from the
excessive voltage source, and check that you are probing the correct signal using the correct probe.
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Error messages and badges

This instrument shows a warning triangle symbol and an error message abbreviation in a Channel badge when an error occurs.

Ch1
4 Temper...
alnout Owv..

A Clamp On
4 Jaw Open
1.00 Aldiv
1M

50 MHz

To remove the message from the badge, clear the error.

System badges

System badges (in the Settings bar) display the main Horizontal, Trigger, and Acquisition settings. You cannot delete System
badges.

Horizontal Trigger Acquisition
20.0 ps/div A - Sample
SR:5.00 MS/s § B: 1 - 30.43 kAcgs
RL: 1 kpts Delay: 8.00 ns

Double-tap a System badge to open its configuration menu.

The Horizontal badge also has Scale buttons, shown by single-tapping the badge. Use the Horizontal Scale buttons to increase
or decrease the horizontal time/div setting.
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Common badge actions

all settings for the badge.

Action Result Example

Single tap Immediate access controls (Scale,
Navigation).

Double tap Configuration menu with access to

CHANNEL 1

Touch and hold

Right-click menu with single tap
access to common actions. Typical
actions include turning off a
channel and deleting a
measurement or search badge.
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Configuration menus

Configuration menus let you quickly set the parameters for channels, system settings (Horizontal, Trigger, Acquisition),
measurements, cursor readouts, Waveform view, and so on.

Double-tap an item (badge, Waveform View, cursor readouts, and so on) to open its configuration menu. For example, double-
tap a Channel badge in the Settings Bar to open its configuration menu.

CHANNEL 1

2.00 V/div

1.22 div

Selections or values that you enter take effect immediately. Menu contents are dynamic and can change depending on your
selections, instrument options, or attached probes.

Related settings are grouped into 'panels.' Tap the panel name to show those settings. Changes to panel settings can change
the values and/or fields shown in that panel and other panels.

CHANNEL 1

Probe Type: TPP1000
Serial Number: CUB0086
Version: v0.03
Attenuation: 10 X
Propagation Delay: 530 n s

Tap anywhere outside a configuration menu to close it.
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To open Help content for a configuration menu, tap the question mark icon in the upper right corner of the menu.

Zoom user interface elements

28

Use the zoom tools to magnify waveforms to view signal details.

1497-015

The Zoom Overview shows the entire waveform record.

NOTE. Using pinch and expand gestures on the Zoom Overview waveforms changes the horizontal time base settings.

The Zoom Box shows the area of the Zoom Overview to display in the Zoom View (see 4). You can touch and drag the box
to move the area to view.

NOTE. Moving the Zoom Box or changing its position does not change the horizontal time base settings.

The Zoom icon (in the upper right corner of the Waveform View) switches zoom mode on and off.

The Zoom View shows the zoomed waveforms as marked by the Zoom Box. Use pinch and/or drag options in the zoom
view to change the zoomed area of interest.

NOTE. Pinch, expand, and drag gestures in the Zoom View only change zoom magnification settings and Zoom Box
position.

Use the Zoom Title Bar controls to adjust the horizontal size and the position of the zoom area. Click or tap the + or -
buttons or use the A and B multipurpose knobs. Double tap the zoom scale and position fields to enter a value using a
numerical keypad.

NOTE. Touch the Zoom Position or Horizontal Zoom Scale fields before using the multipurpose knobs to adjust the
zoom.
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Using the touchscreen interface for common tasks

Use standard touchscreen actions, similar to those found on smart phones and tablets, to interact with most screen objects. You
can also use a mouse to interact with the Ul. The equivalent mouse operation is shown for each touch operation.

See the table to quickly learn the fundamental touch operations.

Table 3: Common touchscreen Ul tasks (with mouse equivalents)

Task Touchscreen Ul action Mouse action

Add a channel, math, reference, or bus | Tap an inactive channel button or the Click an inactive channel button or the

waveform to the screen. Add Math Ref Bus button and selecta | Add Math Ref Bus button and select a
math, reference, or bus. math, reference, or bus.

Select a channel, math, reference, or bus | Tap the Channel or Waveform badge or | Click the Channel or Waveform badge or

waveform to make it active. waveform handle. waveform handle.

Display scale or navigation buttons on a | Tap the badge. Click the badge.

badge (waveform, measurement
search, horizontal).

Open a configuration menu on any item | Double-tap the badge, view, or other Double-click the badge, view, or other
(all badges, views, cursor readouts, object. object.
labels, and so on).

Open a right-click menu (badges, views). | Touch and hold on the badge, Waveform | Right-click the object.
View, or other screen item until a menu

opens.
Close a configuration menu 2. Tap anywhere outside the menu or Click anywhere outside the menu or
dialog. dialog.
Move a menu. Touch and hold the menu title barora | Click and hold the left mouse button on
blank area in the menu, then drag the itle or blank area and then drag to new
menu to new position. position.

Change horizontal or vertical settings Tap a badge and use the Scale buttons. | Click a channel, waveform, or Horizontal
directly on a waveform. Or, use pinch/expand gestures. badge and click on the Scale buttons.
Vertical changes only apply to the
selected channel or waveform; horizontal
changes apply to all channels and

waveforms.
Increase or decrease the zoom area Touch and hold two fingertips on the Click and drag the zoom area.
(while in Zoom mode). waveform view, move them together or | Click the + or - buttons on the Zoom Title
apart vertically or horizontally, lift from bar.
screen, and repeat.
Adjust the zoom position (while in Zoom | Touch and drag in the zoom area to Click and drag in the zoom area to adjust
mode). adjust the position of the zoom. the position of the zoom.

T Not all measurement or search badges display navigation buttons.
2 Some dialog boxes will not close until you click an OK, Close, or other button in the dialog.
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Task

Touchscreen Ul action

Mouse action

Quickly scroll or pan a waveform.

Touch and drag in the waveform.

Click and drag in the waveform or list.

Close or open the Results Bar to

increase the Waveform View area.

Tap on the Results Bar Handle or
anywhere in the border between the

Waveform View and the Results Bar.

Click the Results Bar Handle or
anywhere in the border between the
Waveform View and the Results Bar.
Click and drag the Results Bar divider.
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Set the date and time

Set the date and time so that saved files are marked with the correct date and time information.

1. Double-tap the Date/Time badge (bottom-right of screen) to open the configuration menu.

DATE AND TIME

2019
=

2. To turn off showing the date and time on the screen, tap the Display button to Off.

To turn on date/time display again, double-tap in the blank area where the date/time badge was displayed to open the
configuration menu and set the Display button to On.

3. You may also tap the Year, Day, Hour, Minute, or UTC Offset fields and use the multipurpose knobs to set the fields to the
correct time.

You may also double-tap the fields and use the numeric keypad to set the time.
4. Tap Month and select the month from the list.

5. Tap anywhere outside of the menu to close it.
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Download and install the latest firmware

Installing the latest firmware helps ensure that your instrument is equipped with all of the best available measurement and
analysis improvements.

Prerequisite: Save any important on-instrument files (waveforms, screen captures, oscilloscope setups, and so on) to a USB
drive or network. The installation process does not remove user-created files, but it is a good idea to back up important files
before an update.

Update oscilloscope firmware from a USB drive

Prerequisite: Determine the current version of firmware installed on the oscilloscope (Help > About)

Open up a Web browser on a PC and go to www.tek.com/product-support.

Enter the oscilloscope model number in the search field and click Go.

Scroll down the screen and click the Software tab.

If the listed available firmware version is newer than what is on your oscilloscope, select and download that file to your PC.
Copy the firmware install file to a USB drive.

Insert the USB drive into any oscilloscope USB Host port;

N o o a o bd =~

Power off the oscilloscope and then power on the oscilloscope.

NOTE. Do not power off the oscilloscope or remove the USB flash drive until the oscilloscope finishes installing the
firmware. The oscilloscope displays a message when it is OK to turn off the oscilloscope.

The oscilloscopes detects the USB drive with the firmware file and starts the installation process. Follow on-screen
instructions to install the firmware.

8. When the firmware install is finished, remove the USB drive and restart the oscilloscope.

To confirm the firmware installation:
a. Tap Help > About in the Menu bar.

b. Verify that the firmware version number listed on the screen is the same version that you downloaded.

Run Signal Path Compensation (SPC)

32

Run SPC at regular intervals for best measurement accuracy. You should run SPC whenever the ambient (room) temperature
has changed by more than 5 °C (9 °F) or once a week if you use vertical scale settings of 5 mV/div or less.

Signal Path Compensation (SPC) corrects for DC level inaccuracies in the internal signal path caused by temperature variations
and/or long-term signal path drift. Failure to run SPC on a regular basis may result in the oscilloscope not meeting warranted
performance levels at low volts per division settings.

Prerequisite: Disconnect all probes and cables from the front-panel channel inputs and rear-panel signal connectors.

1. Power on and warm up the oscilloscope for at least 20 minutes.
2. Tap Utility > Calibration.

3. Tap Run SPC. The SPC Status readout shows Running while SPC is running. SPC can take several minutes per channel
to run, so wait until the SPC Status message changes to Pass before reconnecting probes and using the oscilloscope.
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4.
5.

Close the Calibration configuration dialog when SPC has completed.

If SPC fails, write down any error message text. Make sure that all probes and cables are disconnected and run SPC again.
If SPC still fails, contact Tektronix Customer Support.

Compensate TPP0250, TPP0500B, or TPP1000 probes

Probe compensation adjusts the high frequency response of a probe for best waveform capture and measurement accuracy. The
oscilloscope can automatically test and store compensation values for TPP0250, TPP0500B and TPP1000 probes.

The oscilloscope stores the compensation values for each probe/channel combination and automatically recalls the
compensation values when you plug in the probe again. Probe compensation status is shown in the Probe Setup panel of the
Channel configuration menu.

If the Probe Compensation Status field displays Pass, the probe is compensated and ready for use.

If the Probe Compensation Status field displays Default, the attached probe has not been compensated and needs to have
this probe compensation procedure run.

If the Probe Compensation Status field displays Fail, the attached probe has failed the probe compensation procedure.
Reconnect the probe and run probe compensation again.

If there is no probe compensation status field shown in the panel, the oscilloscope cannot store compensation values for
that probe. See the oscilloscope Help for how to manually compensate passive probes not supported by the probe
compensation function.

Each compensation generates values for a specific probe and channel combination. If you want to use the probe on another
channel and desire to compensate the new probe-channel pair, you must run a new set of compensation steps.

Each channel can store compensation values for 10 individual probes. If you try to compensate an 11th probe on a channel,
the oscilloscope will delete the values for the least recently used probe and add the values for the new probe.

Use this procedure to compensate a TPP0250, TPP0500B, TPP1000, or other supported TPP-family probe that shows a Default
status when connected to the oscilloscope.

NOTE. A Default Setup does not delete probe compensation values. A factory calibration deletes all stored probe compensation
values.

Prerequisite: The oscilloscope must be powered on for at least 20 minutes before compensating a probe.

1.
2.

Connect a supported probe to an input channel.

Connect the probe tip and ground lead of the probe to the PROBE COMP terminals on the lower right of the oscilloscope
(see following image).

& Wrist Band

Probe Tip -

Figure 4: Probe Comp connections.
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Connect the probe tip to the 1 kHz source and the ground clip to the ground. For best results, remove any probe tip
accessories and hold the probe tip directly onto the 1 kHz connector.

NOTE. Connect only one probe at a time to the PROBE COMP terminals.

Turn off all channels.
Turn on the channel to which the probe is connected.
Push the front-panel Autoset button. The screen displays a square wave.

Double-tap the badge of the channel that you want to compensate.

N o o M o»

Tap the Probe Setup panel.

If the Probe Compensation Status says Pass, the probe is already compensated for this channel. You can move the probe
to another channel and start again from step 1 or connect a different probe to this channel and start from step 1.

If the Probe Compensation Status says Default, continue with this procedure.

8. Tap Compensate Probe to open the Probe Compensation dialog.

9. Tap Compensate Probe to run the probe compensation.

10. The probe compensation is finished when the Probe Compensation Status displays Pass. Disconnect the probe tip and
ground from the PROBE COMP terminals.

11. Repeat these steps for each supported passive probe that you want to compensate for this channel.

12. Repeat these steps to compensate supported probes on other channels of the oscilloscope.

NOTE. For most accurate measurements, open the Probe Setup panel and verify the Probe Compensation Status is Pass
whenever you attach a probe to a channel.

NOTE. A probe compensation failure is most likely due to intermittent connection of the probe tip or ground connection
during the probe compensation operation. If a failure occurs, the oscilloscope will re-use the old probe compensation values
if they existed prior to the failed probe compensation operation.

Connect to a network (LAN)

Connecting to a network allows you to remotely access the instrument.

Work with your network administrator to obtain the required information to connect to your network (IP address, Gateway IP
address, Subnet Mask, DNS IP address, and so on).

1. Connect a CAT5 cable from the oscilloscope LAN connector to your network.
2. Select Utility > I/0 on the menu bar to open the I/O configuration menu.
3. Tap the LAN panel
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4. Obtain or enter the network address information:

= [f your network is DHCP-enabled and the IP address field does not already show an address, tap Auto to obtain the IP
address information from the network. DHCP mode is the default mode.

= [f your network is not DHCP-enabled or you need a static (non-changing) IP address for this instrument, tap Manual
and enter the IP address and other values provided by your IT or system administrator resource.

5. Tap Test Connection to verify that the network connection is working. The LAN Status icon turns green when the
instrument successfully connects to your network. If you have problems connecting to your network, contact your system
administration resource for help.
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Compliance information

This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies. This product is intended for use by professionals and trained personnel only; it is not designed for use in households or
by children.

Questions about the following compliance information may be directed to the following address:
Tektronix, Inc.

PO Box 500, MS 19-045

Beaverton, OR 97077, USA

www.tek.com
EMC compliance

EU EMC Directive

Meets intent of Directive 2014/30/EU for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1, EN 61326-2-1. EMC requirements for electrical equipment for measurement, control, and laboratory use. 234
= CISPR 11. Radiated and conducted emissions, Group 1, Class A

= |EC 61000-4-2. Electrostatic discharge immunity

= |EC 61000-4-3. RF electromagnetic field immunity

= |EC 61000-4-4. Electrical fast transient / burst immunity

= |EC 61000-4-5. Power line surge immunity

= |EC 61000-4-6. Conducted RF immunity

= |EC 61000-4-11. Voltage dips and interruptions immunity

EN 61000-3-2. AC power line harmonic emissions

EN 61000-3-3. Voltage changes, fluctuations, and flicker

This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.

Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.

Equipment may not meet the immunity requirements of applicable listed standards when test leads and/or test probes are connected due to coupling of electromagnetic
interference onto those leads/probes. To minimize the influence of electromagnetic interference, minimize the loop area between the unshielded portions of signal and
associated return leads, and keep leads as far away as possible from electromagnetic disturbance sources. Twisting unshielded test leads together is an effective way to
reduce loop area. For probes, keep the ground return lead as short as possible and close to the probe body. Some probes have accessory probe tip adapters to
accomplish this most effectively. In all cases, observe all safety instructions for the probes or leads used.

For compliance with the EMC standards listed here, high quality shielded interface cables that incorporate low impedance connection between the cable shield and the
connector shell should be used.

MDO32, MDO34 Installation and Safety Manual 37


http://www.tek.com

EMC safety and environmental compliance

38

Australia / New Zealand Declaration of Conformity - EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

= EN61326-1 and EN 61326-2-1. Radiated and conducted emissions, Group 1, Class A.

Safety compliance

This section lists the safety standards with which the product complies and other safety compliance information.

EU declaration of conformity - low voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Union:
Low Voltage Directive 2014/35/EU.

= EN61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use — Part 1: General
Requirements.

= EN61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use — Part
2-030: Particular requirements for testing and measuring circuits.
U.S. nationally recognized testing laboratory listing

= UL 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use — Part 1: General
Requirements.

= UL 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use — Part
2-030: Particular requirements for testing and measuring circuits.

Canadian certification

= CANJ/CSA-C22.2 No. 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use
— Part 1: General Requirements.

Additional compliances

= |EC 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use — Part 1:
General Requirements.

= |EC 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use - Part
2-030: Particular requirements for testing and measuring circuits.
Equipment type

Test and measuring equipment.

Safety class

Class 1 - grounded product.

Pollution degree description

A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment for
which they are rated.

= Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

= Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is caused
by condensation must be expected. This location is a typical office/lhome environment. Temporary condensation occurs only
when the product is out of service.
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= Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

= Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical outdoor
locations.

Pollution degree rating

Pollution Degree 2 (as defined in IEC 61010-1). Note: Rated for indoor, dry location use only.

IP rating
IP20 (as defined in IEC 60529).

Measurement and overvoltage category descriptions

Measurement terminals on this product may be rated for measuring mains voltages from one or more of the following categories
(see specific ratings marked on the product and in the manual).

= Measurement Category II. For measurements performed on circuits directly connected to the low-voltage installation.
= Measurement Category lll. For measurements performed in the building installation.

= Measurement Category IV. For measurements performed at the source of low-voltage installation.

NOTE. Only mains power supply circuits have an overvoltage category rating. Only measurement circuits have a measurement
category rating. Other circuits within the product do not have either rating.

Mains overvoltage category rating
Overvoltage Category Il (as defined in IEC 61010-1)

Environmental compliance

This section provides information about the environmental impact of the product.

Restriction of hazardous substances
Complies with RoHS2 Directive 2011/65/EU.

Product end-of-life handling
Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and use of natural resources. The equipment may
contain substances that could be harmful to the environment or human health if improperly handled at the product’s end of life.
To avoid release of such substances into the environment and to reduce the use of natural resources, we encourage you to
recycle this product in an appropriate system that will ensure that most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according to
Directives 2012/19/EU and 2006/66/EC on waste electrical and electronic equipment (WEEE) and batteries. For
information about recycling options, check the Tektronix Web site (www.tek.com/productrecycling).

Perchlorate materials. This product contains one or more type CR lithium batteries. According to the state of California, CR
lithium batteries are classified as perchlorate materials and require special handling. See dtsc.ca.gov/perchlorate for additional
information.
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C Cursors button, 9
cable lock, 15 Default Setup, 9

description, 9
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Scale knob, 9 LAN, connect to, 34
Scale knob (horizontal), 9 Level knob, 9
Single/Seq button, 9 lock to bench or rack, 4
Slope button, 9 LXI, 8
Touch Off button, 9
Trigger, 9 M
USB ports, 9
Vertical, 9 Math button, 9
Measure button, 16
G measurement badge, 22-26
GPIB talk/listen address, 8 Menu bar, 16
menu panels, 27
H menus, 27

Mode button (front panel), 9
mouse touchscreen Ul equivalents, 29
multipurpose knobs, 9

handle rotate, 1

handles, analog and digital, 17
HDMI output (rear panel), 15
High Res button, 9

Horizontal controls, 9 N

how to
check power-on self tests results, 6

compensate TPP250, TPP0500B, TPP1000 probes, 33
connect probes, 6

navigation buttons, badges, 22-26
network, connect to, 34

connect to network, 34 0

connect to PC using USB cable, 8 operating

download, install firmware, 32 altitude range, 2

remote access the oscilloscope (from Web), 8 humidity range, 2

run signal path compensation (SPC), 32 temperature range, 2

set GPIB talk/listen address, 8 operating power requirements, 2
set time, 31

update firmware, 32 P

use mouse with the Ul, 29
panels, menu, 27

I pinching and handle rotate, 1
inactive channel buttons, 17 position
knob, 9

Input connectors (front panel), 9

. . . knob (horizontal), 9
input signal level requirements, 2

power cord connector (rear panel), 15
K power requirements, 2

power standby mode, 5

power-on test results, 6

powering on or off, 5

L probe
compensation (TPP0500B, TPP1000), 33

knob A, 9
knob B, 9

LAN port (rear panel), 15
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compensation connectors, 9
compensation TPP250, 33
errors, 24
inputs, 9

probes, connecting, 6

proper handle rotate, 1

R

rack mount kit information, 7

rear panel
AFG Out, 15

AUX Out, 15

cable lock, 15
connections, 15
Ethernet port (RJ-45), 15
HDMI output, 15

LAN port (RJ-45), 15
power cord, 15

security cable lock, 15
USB Device port, 15

USB Host ports, 15
record view, waveform, 17

Ref button, 9

related documents, viii

remote access (e*Scope), 8

remote access (Web-based), 8
remove AC power from instrument, 5

requirements
altitude, 2

environment, 2
humidity, 2
power, 2
signal inputs, 2
temperature, 2
Results bar, 16
Results Table button, 16
RF, 20
RM3 rack mount, 7
run signal path compensation, 32
Run/Stop button, 9

S

Save button, 9
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Scale knob, 9

Scale knob (horizontal), 9
search badge, 22-26
Search button, 16

security cable lock, 15

set
GPIB talk/listen address, 8

time, 31
Settings bar, 16
signal input levels, 2
Single/Seq button, 9
Slope button (front panel), 9
SPC (signal path compensation), 32
standard accessories, 1

T

TekVPI input connectors, 9
time, how to set, 31

Touch Off button, 9
touchscreen Ul tasks, 29

trigger
level indicators, 17

position indicator, 17
Trigger controls, 9

turn instrument on or off, 5

U

USB cable, connect to PC, 8

USB Device port (rear panel), 15
USB Host ports (rear panel), 15

USB ports (front panel), 9

using mouse with the touchscreen, 29

vV

Vertical controls, 9

W

waveform
expansion point, 17
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record view, 17
waveform badge, 22-26

Waveform View, 16

Z

Zoom box, 28
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zoom icon, 17
Zoom overview, 28
Zoom title bar, 28
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1B) BIERE, A v B A a—IERBIZE T LT 74 Vv a v OEERERINET, A7
— Y E®Run/Stop (3T f51k) RAANTET 7 A4V ay « AT —HXARERINET,
Cursors (1 —Y)V) RE NI —Y NEA U T34 7T HETT, I—YLVEBEHxE5
WITIA ) 7R LE S, I— YLD X A T EEERRET DT, =YD U—KT U b
2R T T DM FF =V e N— (TA4Y) EE2RZ T LT, a7 4T L—
gy Ama—%REET,

Fast Acq™ |3 Fast acquisition (B3R 7 7 1 23 3 L) E— FOA ML & B 24T 9 KERE T, FastAcq
TIX, WIEOT 742y a MTObNDIBOT v R« A4 ARBEHRESNDTZD, 7Y v TFReT v
ke PNV RIREDOBPERIA X FThoThH, MVIAL, BRTHZENTEES, X DHON
WS S RE OMMBICRI D £, £z, @ET 7 A V¥ 3 (FastAcquisiion) £— KT,
FEABERED R U CI R 2 R R CTE £,

Single/Seq (Hi3& “Hifit) Z{HEH &, HEOWET 74 Vv a e, HELLEREOT 74T a
VEFATTEET (Acquisition (77 AT ay) a7 4 b—v gy s A= a—TiE),
Single/Seq (%8, idfse) Z#H9 & RunfStop (4T f51k) E— RBA 72720, BEOT /A4
TarNEITENET, RECOEIZT 7 A4V a L DAT—F 22 R UET (R0 @ SR
=HRT 7 A Vv a VT, HOEORIT=1R) T - 4 X2 MEDL), b 9 —FF Single/Seq (HL%
HfGE) AT EBIOHERET 7 A4 Vv a URETENET,

HighRes (/N1 L) E—RTIX, 7747V al A Z—ULDFTXRTCOY T ILOFEN
Bt Ed, HighRes (/A L) (T, @i CIRAEIROEE 2R R L E T,

Clear (7 V7)) IBAEDT /A Vv a vy EEMEEZ AT NHIHET HHETT,

2. WH/ 7,

10

WH,Z (A B) :ILWH/ 7ABLUBIX, V—YAEBEILIZD, X—L%EWETHHE50,
AT 4T =g A a—DANR YV ANTHRT A—FEERETHHAITHEA LT,
WH 7E2HERATEDLANR Y 7 AZRINT D ERRENT ) ITREDETEN, £/ T TE
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P& ER D FER

DANNRy 7 ANOEEZERECTCEET, &/ 70, 77 a VOETIERHTEARFIZY 70
AﬁiT [/ \35 ﬁ—o

WH 7 73 & BaZER/ S0 Fine (BFRTE) £— FRERNIC/2 Y £, Fine (AR =<
— REETT DL, FO) 729 —EMLET,

E: v REIDFIFTOBEE, v b1 —D 2% Coarse (#1757%) F Fine (#4357%%)
DRI THLFT,

3. Trigger (V) v hm—b:

TRIGGER
Trig'd

Level

Set to 50%

va
N

Auto

Norm

3514012

= Force (F&fHl) 1%, WIEOEEDRA L FTRIH - AR EEHRHEIL, 7740V ara®y
T T HERETT,

m Level (L-UL) &, EE 0BT AREOIRIE L ~ANED R v T o Pvarshipdns kol
RETHHEETT, Level (LUL) JTOEIX, TaT b D Y TUSNO NYF -+ Y —R
ZRLET, FUH - AATIZHLT2OD L~V EEZIIZEDOMD NI H « 7 AV 757 AT
NYFEIp L X2 (Trigger (FRUA) ar 747 b—vay s A=a—nH0RET5), Level (L
V) ) TR TY, T/ TEBLT, ALy alb R LoULEEEO p-p RIEEFHO 50%
WCRELET,

m Slope (Au—7) FMRHETDER T Yy a ol (B~E. B~K 3550 %
RET HHEETT, BIRAMY IETIIEZORZ 2L ES, MUT - XA 7Tk L THID A
n—"7 7 AV T A TR0 ERE X2 (Trigger (KU H) oar 747 b—vay s A=a
—MNHRET D)., Slope (Au—7F) RH AT TT,

= Mode (5—F) . FUH « A FOFEIZ L DWIROEE ZRET D7D DOERETT,

m Auto (A—1F) RUF - F—=FRTiX. MUY - A bOREOHEICERRL ., WBEOT 7
A arERRBMTEONEST, MIT « A MRBRAELZSEEICIE. BELZEENE
IRENET, PUT - AU IRRELRWEGAIZIE, AER N H - 42 N &2l
BAESE, REEREENERINET,

m Normal (/—=/) RUN - E—FTIZ. BAR BRI « AR IBRGFHET D EEORFEED
TIATvaryERRBPTOND LX), BENFREINET, NI ATREAELRWEEIT,
AICEDIAALTERE L a— RNRFOFEEERINET, AIOEENLZWIGS., BRITFERS
NEH A,
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AR OHA

4. \Vertical (FEEH) =2 Fr—/L

Position
~ EE
... (B
@
@) Fine

3608-011

m  Position ({iTf&) IZ. IR LR FDHEE A7 ) — 0 ECETICBE) S 5142 T3, Position
(&) / 7oz, 2O/ 7 THEL TW L EFELZRLTWET, /72 L T, B~ FL
BT 4 AT VLA ORI LET,

= Scale (A7 —/) i3, BIRLBEIEOREEFEX S Z EIRIBHEMZBET DEETT, 27—
JUAEIE, Ny DICE RSN ET, Scale (A7 —/v) /7 OMix, 20/ 7 THIEIL T 5
BERLTNET,

= Channel (Channel) « RFZ &5 & KDL IITF ¥ o xrDA Ly FEoR), BIR, 7237 T
XFET,

" T CRADRFRSNTORNES, Ty R BRI EMTLEOT v AARBIRE
2 —lCRRESNET,
B FXURARAT Y= BICRL BIRSNTOWRWES . 20T v U RVDOR Y a2 T
LEDTF ¥ U RANBERSNET,
= TR RABAT =2 EChH o TRIREN TV DEE, TOF ¥V RAVDRE 2 i &
ZOF X XN BAT7 (BIRE 22— bHIER) 1280 7,
= Math (B5) RZ 2D & ROLIITEPE = — ECORAKIEOBIMRBERE FTCTEE
—é—o
w  HEEESRVES . Math (B A ¥ A9 L P Y 2 — ICHE R E B S, Math
(W) oav7 g7 —vay s A=ma—PREET,
» JABREAFRENTOTHRBRENTORWEE, ZORF 24 L HEREISRIR S
NET,
o HREEN 1 OETRRSNTERRSNTWDEGEE, ZORY AT EEEREN A7 (K
e 2—noHIER) 12720 9, WBERRTDIIZORF &b ) —ERLET,
= Ref (V7 7L 2R) RE &M E ROESICHEFEE2a—ETOY 77 L X (RIFHH) B
EDIBIMPEIRNE ETTE T,

B U 77 LU RN WES. Ref (U7 7 LX) RE L %H4 L Browse Waveform Files ()i
W77 ANDER) Oary 7471 —Yay - A=a—0EEXET, BEZ7744 Cish) %
RO TEIRL, Recall (V=a—L) 2%y 7458, V77 Lr AlENAR— RSN TER
SNET,

o VT VRN DRETRRSNTWDGE . ZORZ 2T L U7 7 Lo AR A
7 (BB E 22— bHIER) (20 T, WEEZRRTDITIEZORZ v 2d 5 —EMLET,

B HEOV 77 L RAFRIENRERINTWDEGEE, ZORX U EHTLEELY 77 LU AFEEO
BRI E T,
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B Bus (RR) RAUVEMHI L, ROXIICEEE 2— ETORRWEEOBMSCERE FEIT T
ﬁ—o
. ARG AE, Bus (NR) REZ AT EEEE 2 — 2 XA BIME iU, Bus (N
R) Dar T4l —vay s Ama—RNEXET,
B ARZRABEN OFITEREINTWDLEA, ZORZ U EHTEARREERAL 7 (HEE 22—
DHIER) 272 £9,
B 2ODNRAWHENFREINTWDLEA, ZORY U EHT EENREEOBRBE Y KIS E
7
B RFARZ NI, W¥E 22— FICRFIEZBINL, B R A A SRR KA A ~D8 0 B2
ETVET, W AL ORBIES R CTAT L2 AT bT A TF T4 Y R4/
F9, W RAAL NIV B2 256, KR RAA COWEER Y A N7 EhET,
®  Digital (T VX)) RE NI VEE 2 —ICT VX AEENBMESND, KRB E2—DF
UH TR ER I N E T,
= FULIL T CRLRERRSNARVEE Digital (57U 4 V) RE VBT EEHEOT ¢
FIBE NI ET,
TN Ty AR AT Y = B2 THIERS ATV WA Digital (7% /1) AR
AU LT UL F e URURERINSNE T,
= TUSN e FY RN Y= RIS VERSN TV S84, Digital (7795 L) ARA
BT LT XL Fr AN E TR0 FET EEE 2= 0HIBRSNET),
5. Horizontal (ZKF#h) =2 hr— b

HORIZONTAL

3608-012

= Position (fiZf&) 1%, Kz A7 ) —r ETEAIIBEISED (WELa—FO MU - R A2 b
DAEZEET D) BEETT, 2O/ 7aid e, M A X PP HRBEOHRICEBE L ET,

m Scale (AT —/V) iE, AV RAI—TOEEKEEREX YT L O/ NT A —% LH% o7 VIR
RGRA— R EFET HRERETT, Scale (R4 —)L) [IT_RCOWEFICHEH S NET,
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6.

m TouchOff (¥ vF -4 7) #FMITHEX T « A7V —UHERL 7720 ET, v T -
ATV =2 BNA 71275 E TouchOff (¥ v F « 7)) REUBEITLET,

m Save (fRTF) ZMiATH L. AZ &2 1 BT T, BEDFile (77 A1) >SaveAs (ZEi%
fHF TR OBREEFEALTC, 227UV —r vavh (FA—Fv  Ama—tXA4T7al R
v I AEELe), W7 7 AV, HEsRER EERETEET,

R RTEIEE) L2112, File (Z7Av) >Save (fRTF) F7-1ZFile (Z77A/V) >SaveAs
(&R ZAHT TRTE) OEENMTOR TV DH5A1ZIE, Save (f:1F) &4 L. Hiila] Save As
KT TR a7 4 b—v gy « A=ma—TCRELEEFICEOREDO 7 7 A
VISR S IVE T,

w HEER AR L2k T 7 A VRFEE R IT D7 o T2 55121, Save (fRTF) Z=HF9 &
Save As (A& CTRAF) O 747 L—a - %%:—#%%iﬁ RIFT57 7
ANDEAT (A7 V=2« Fx T Ty, WHARE) Z2BRTLH-OOF 72N L, B
INRT A= LRIFREZREL T, OKZEIRLET, SEE L1 2EITEEDO 7 7 A VMR
TN ET, &kl Save (fR7FE) 2L, RIUEEOZ 7y A VBRRIESNET,

= ScreenCaptures (R 27 U —r « ¥ 7F¥) L, RARShdHar 74 7‘1/~~‘/a Ve Az a—
LA TS Ry I AR EEEGOIAT =Bk E Xy FF v HHEET

= DefaultSetup (T 74/ bk &y b7 v 7)) I, Ay Ra—TFE K, Epiﬂi A r—
. LR E) BT 74V MNREICRTHEEETT, T 74 By 8T v SR — R EAIC
HHEHDOELZITWVER A,

B Autoset (A—hEv b)) WFLELKEEZ BEIFR T DHRETT
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1. VU Reaxy2erla—7fEaxy 2

po & Wrist Band

Probe Tip

3608014

= IR 2?\7573:7°D~7“%%E:14"<75’6‘i\ AHEDOL T, HiEARAEICHY £3, 77
VReaxsa (F—ZANONERR) 1E, (LY REZEZE L) BRI S R A v
T, DUT OHLY #0713 A RIS %* 15 (ESD) ZBL <o DFESBIEY Xk« A B
T v T ZOBHEAA L MTEDY T ET

o Tue—T7ERERTICE, ST R axs g (o T) & AkHz 0 FRE Y — A (FRlo
2T7) WHY x%7mw7®mﬂﬁﬁm%®%%(fu~7%E)_ﬁmbif Fynaza
=TI ZOEFEFAHLT, ¥ R—FrEn b7 —7 (REGBICEHES TS e —7%
@@)@E%ﬁﬁ%ﬁwifoWW%wﬂ\wwmmﬂaifﬂﬁwmwﬂw7n~7@%ﬂw

—)EBBL TS,

8. USBARN «A—hk (USB20) :
[~ I -~ ]

£ )
= \ﬂ[ﬂ |

3608-015

USB 2.0

B USB AR— MIRTE/ SRV DE T EBEASNZNCHY FT, T—% (oY 7 bo T B, K
%\%E\xyu~y-#¥7%¥&8)®%T%):—wﬁﬁ E72USB7T7 vy = RIA4T
BEHGT D0, FlRIE~ U RARF — AR — R OIS 8kt L T 7280,
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Hfs D FEH

=111

9. Fm—7 . axs 4

TruaZ ANJjaxs ZiX, TekWPH|IE 71—, TekVPI llif 7 v —=7", BNC %8~ 1 —=7" P6316

Ry e Fa—T BNC =T DT RTICHIE LTWET, 72— Z0HE ~— V) R B
LT &N,

BRI RN D EEREET

BRI ASFNDOEREIIL, A n A a—T~OFERMEE, Ky FT—=7  USBT AR, ETA, V77
L AE. ARG ) D#ERE D T2 DI L £,

Kee-
[E =P Mfr. Compliance Contact
Tektronix, Inc.

Patents associated with this product,

osc
PO Box 500, MS 19-045
if any, can be found at: & X ﬂ <sp. @ Beaverton, OR 97077, USA
www.patentlabel.com/tektronix — c us

www.tek.com

AFG Out AUX Out LAN 10/100 [V:pX0) USB 2.0

Device Host
i

ﬁj

3608-023
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BE2R DR

k=111

1. BFR=a—Fax7 2 AKRGERICEESh, FHSNSETRESNIEERA— FOZZHH LT
<TZEWy,

2. AFGOuti|I. 7> a v OIEERK,/ 777 ary - PRkl —% (AFG) HAOEEHTY,

3. AUXOutix, FNUT - AXUITREFIN IV varaElT 5, EITAFG O LRIEESA ML
\i—g—o

4. LAN =27 % (RJ45) 1L, > m2=a—7% 101100Base-T 2 —H /)L« = U7 « X T — 7 kG L
\i—g—o

5. USBF/NA R « F— RFizk V. USBTMC 71 h L& L CA L 1 A a—F % mlEilEd 588102
ClZHa L £ 7

6. USBARARR -R—HFIZLY, UBAEY « TA A, F—AKR—F, I~V AR LET,

7. HDMI A2 L0, A= -7 a7 Xt L CAvn Aa—7 Ol 2 £~ LET,

8. BX2VUT 4 vyl - axZXICLy, BENLRPCBIOY/  —MYarHouy s « F—7 )

EEHALT, Ay rRAa—72{EERREOMOBGINCEE L ET,
=P e f BT 2—R « AT Y—V

5/? AT V= AKD2—W e f U F T 2 — AL, FB, BIEY —FT U b, AvmaRa—702eH
G77?XT%65/?A%X@H/mewﬂaiﬂfwiﬁ

3608-032

1. Azma— s A={ZFROBELEAA =2 =P EENE T,
T ANDORAE, = RBXOT 7 X
B AT aRI—TOT 4 AT VA RE EWED—FRE
= Xy NT—IT 7 ADREE
BT TR MNOEM
. JEEREAEY (TekSecure™) DiHZE
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75D

=111

il
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2.

m T vare Ak CADER—R
#  Help (~V7) B o—7 OEE

BRE 22— RICX,. 7he R, TUOXAER, ERER, V77 L AEE, BLUONNREE
NERENFT, WIRITIE, B RV GREIF) . B U NLE., TV ERNEGEENE T, A
T ZEmDIEH(19 N—) BB LT IEE,

FER (Results) /N—|2i%, W—YNLDFER, A7V —r~OFfERFOBEM, #HE (Results) /S—~0D
RMEDBMEZFEITTL2ar ha—AR3H0 4, BARMICIZUUTO®EY T,

m  Cursors (W—Y)) RE UV EFEATDLE, A AT Y —2 « I— V)V EFR/RTEZET, Mulipurpose
WH) /7% 2y F LTRIZ v T7T50 EHTLE, I—VLEBETEET, I—VILER
EA—=YND)—=RT7 T N2 2lZ 7 456L arviglb—vary s Ama—RHE, I—
INDE A TR A R ETE ET,

m  Measure (HITE) RE L EEHE, av T4 7 b—var - A=a—0E, TI0bRK4O0D
HIEZ BRI L CTHREE (Results) NN—{ZBIMTEET, BINT2KBIEIIIFEBDONNy ORHY £
T, WEARAY CE2MEZ T HE, FOary T4 S L— gy s A a—RNHEET,

= ResultsTable (F#55%&) A& %25 &, WE, "R, REBIOEHEOHBREL AT U —IT
BINTE £9, Measure (HIE) # 7121, #53 (Results) N—I|ZfFET AT R TORENFR S
WWET, Bus (NNR) ZTITiE, BREINTWVAEANAEIZICET AR « T a— RERNE RSN
F9, Search (FR5R) # 7IZiE, EBEA N> FOERNPFR S IVET, Harmonics (FiFfl:) # 7ic
X, mFREOWE/BENFRINET,

m  Search (MifR) ARFLEZHEHI L IBELIEAXRNY RRBEL TCWAREABRT L Cv—2 T F
9, Search (ff%%) % ¥ v 7345 & Searcch (f3R) 2> 74 7L —vay « A=a—NHE, 7F
R Ty RN ET VR F oy RV ORPBRMERRETE T, Search (BsR) /Ny Vo3
BA—lzBmMEnEzT,

m  Measurement GHIE) /N> 2L Search (FR%R) /N v UL, BIER R S BBRFEREZ R L., #R (Results)
N—lZERrREINET, N (URX—V)2BZB L TLEEN,

#XJE (Settings) ~N—(Zi%, Horizontal (KFiil) /3T A—% Trigger (kY ) /3T A—% Acquisition
(B iAdr) 737 A—%  DatelTime (HfFE W) /XT A —F Z5ETE % System (VAT L) Ny

V. Fx RNV E A ITT S Inactive Channel (IE2h ¢ V) ARZ 2| HEKE, V77 Lo AR
. NRAWEET 4 A7 LA IZIBINT 5 Math (&), Ref (77 L2 R), Bus (/XR) R¥ | I
IRT A =B RN E TE B Channel (F %) /Nw P& Waveform (JTB) o PNdH 0 £97,
F xRNV s R CETTEAR S v a2y T T H e FXY RNV EITERER A7 U — BN S
NTRYUNRFREINET, NPk 20FX v TT5HL, TOar 747 b—vay - A=a—NH
XFET, AN USN—D)EBRLTLE SN,

ConfigurationMenus (2> 7 4 /'L —v 3y« A=a—) ZEH L, BRLa2—H A X Tz —R
HEHONTGA—FEBPICELTTEET, a7 47 b—var - Ama—d Ny Y A7 J—r-
FTV el NERIFIAZ V= kA 2R Yy FTUERE ET, 2T g s A= —
B0 =) EZHL TN,
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MmO FEA

k=11

7 ] BRUBER 7 DIE H

2= e f U F T 2= ZADFKEIBITIL, FRea L b — LV OBFERICESL ORISR H Y T, 2D b
By /Tt 22— e A X T —ADFEEEEL R L CHALET,

Meas 1 L1

Amplitude
EAFAY

Search

Chi

2,00 Vidiv | 2.00 Vidiv 15 | et || ovml| ase
¢ ke 011 Bus

1GHz 500 MHz e

1. FERLa—R-tFa—3. 2EKOT7 74V ay, BEICRRINTWAET 740 arow (Iy
INIZER), FUH AR N EEGLEERMA X2 OGN, BED— Y VOBREONE XA L
oA L L7 B 2 — T,

i

FTBRAA—=TTOT I ATy a v OEILRHIAKERIFE A r— L 2 BB L TS558, BIEDT 7
ATV ay s La—FREISICEEL CERENTWAEIFEL a— RO—HNEREND L HITh v
DONMENEFINET,

[

W L= NNT 7T 4 7 ThLHEE, BV a—F « Ea—IZidvhSRmEmH s L TR
— Y NALEPRFITRSNET,
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=111

il
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Zoom (R—2L1) E—FDL&E, HHLa—F - Ea—3dXA—2fE8lIcen 4, X—4 - =z2—% -7
T 2 = R N D) BB LTSN,

BIEE 2 —DYLRAA > b« T A 2243, KB EZ L E T D & S OWRTEOYLRE & LM O bz
~LET,

FUBNLEA =2 F BB L 23— RTRAELTC MY T « A X FOMEEZRLET,

=k TAay (FEra—¢t7ay b Ea—DfFLEIIHA) #F5L, X—2DF L A7 %
U252 LN TEET,

Jo

FUT L e A D=2 T Aa g, FIH - Y—=APRLEDO NI - LYV ERLET,
—HRD NV XA TITHLTIE, BT« LAYULR 2 OMBETT,

Measurement (&) “Search (fr%2) N VIEZNENHER R EMBHEREZRLET, V> (24
R=V) RS LTI EEN,

AEF (Results) /N—dD Ny RIVIFFERN—Z AT 28T, LIS U TEFEAZ U —DHRRE
R TEET, R (Results) N—% 1 ) —FRIZIE, ZONV R T A arvuedy 7 T50,
F A4 AT LA DEMNSEICHP>TATAL T LET,

System (AT L) Ny D& &, IO 70— L% iE (Horizontal (K i) . Trigger (~ U A7),
Acquisition (777 2 3 ), RunlStop (34T fF1k) A7 —Z % Date/Time (AWf)) ZFKRTE %
T, N2 RN—V)EBR LT EEN,

Inactive Channel (#EhF v > V) RE &S &, Fr o FAPEREZRFE 2 —I2, BEE#ETLF v
P s RNy PEREN—IZBMTEET,

Add Math Ref Bus (%7 U 7 7 L' v AN &8 RZ &) & HAERIEOEERE, N ARE A
WEE 2 —IZBEM L, BT 5/ Ny % Settings (B &) S—IZBINTE £,

RFARZ T, AN AL DT 4 AT VLA G, RFARAY UEBMLET, Ny V% 20
w7 L CRFav 74 ¥al—var - A=a—%2M& RFANEXRELET, ZORZ IIRF AT
Ta VINENEOHRT I T 4 T £,

AFGRHZ LA H L ARG 74/ —ay « A=a—%5BWCAFG N IEREL., FNEEL
{LTCExFET, ZTORFUBIFEETAIDIZAFGE S a v NA VA ML ENTWAEEIZERY 3,

DWMARE L &EiH L, 7Fus« Fu—7 %> TDUT L<DCEEMNTE, ACRMS BEME. /21T
DC+ACRMS EEMEA#EM TE £+, ZORF %X v 7 LTDIM Ay PZ2FE (Results) /X— (2B
mur, ary74 7 —vay - A=ma—%EES, DIMA T a &5 & Trigger (~VU ) N
v« A==2—0 Mode & Holdoff (&— R&F—/L R4 7) SRt M) BREEE D 22T 7%
ALTHEMET D TEET, ZORXUBFETDHDOX, DIMA S a U4 A =3
TWAHEHEITIRY £,
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P& ER D FER

0. Ny VE2EX v TTHE TOarT 47 b—vay s Ama—RNHEET, Ny 4 =)k
ZRLTLIEEN, 22770 —2g « X=2—30 =D)L TLEEN,

Channel (F > /) Ny P E7-1E Waveform () Ny U&EBIMLT, HWEA Yy DHEBIGHE D &
SR o eBEITIE, WAy VEREOMEICH DA T a—L - R EHX T L, AT a—
NTHZET, BRTWARY PEERSELZENTEET,

N, TNENOEFROWE N> RMZL T, TOWEED Y —AZFHATEET (Fv o r/ML Cx, HE
IM, U7 7 LU RAEEIZ R, NAEILBX), 2OV RViE, T 740 FTiE, BEO0E
JEL-UZH Y £9, BUERIRSN TV D N RVEIEA SN, BRI TH2RWEE AN RL
TR BRNFERENET,

W N RVE2EZ y TT AL FORFEOa L T 4 T — gy« Ama—RHEET,

FTIUHI e Fx RNV DEE, WIE N RVIZIETF ¥ v e & DO~D15 DEBID T ¥ % VAE 55
BB EDT IV TERRINET,

FTIORENPIN RV TNT ) oI E TUXL Fx RO T 4T L—a - R
—a—NHEET,
TUBNGENS RVERON RVIZRT v 7325 L WIEE 2 —KNTIIbOESOAEN AL
B FET, TUXINEBTNANY RVET LTINS KT 7 T LW —TRNEfR SN ET,
BIRLIZTOHL - TA—TFTE B> Kovid, TEEGNLE  (Vertical Position) =22 b o — /L CH#j
MWTZENTEET,
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AR OHA

R R R RS NAHE
TOREY T, BAEENAA DT 4 AT VA EEERL, BALES,

AR R A AV OFREFINCT BT, AiE ARV DORF RZ 2T, T A AT LA DRFARZ %
By LTLIEEN,

D e (T 2 — ADFEICIT. FRO T hu— L OB SN O RS EE N B Y £,

IHI‘M hn ;F ”\\[

i M“”WM”M”WWWWW“WWw

i

180Gz
RF —— i
0.00 dém 1| 2o M h N i 2400000000 GHz [ Sample

m 0 dardiv g Spen: 1200000 Ghz S Mar 2019
s ‘ RBWY: 120 MHz 07:09:11

1. EEAKY 7L
B4R )E % (Start Frequency)
FEUE L~ (Reference Level)
TE[E A -7 — /L (Vertical Scale)
0 JE % (Center Frequency)
AN B KOG RRE O i IR
12 1E &% (Stop frequency)
FME~—7

Free Run
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10.

1.
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13.
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/

Utility

;lp YL % I‘JJ [..TI u’\f’ﬂh

Lk i

©eee ®

3608-044

a. RF RNL—R -« 4T —2RHEHEL~JLZEDPNTOET,
b. KIFMIE, HEKE ML —ARNF L OGEEICERRINET,
c. KRICFAZ, FHENL—2ARF L OEEICERINET,
d. KIXFENIE, /=< hL—ARL L OEAICERINET,
e. /IXFmMIE, B/ME R L—ARF U OGEICFRENET,

BABRNINTWAD L —RA A Lo DB TAS T4 bEREINET, KTIE, B/MERL—A
ERTIINLFEm BN, T4 PRI TWET, Zud, &/ME M L—2ABEAERIN TN D

ZEERLTVET,
o () (2 (13

(i Iqﬂq'f y f'

”"H

¥
T T b
W j w,”‘““"‘

ree Run
27 Mar 2019
07:36:13

3608-042

==/ (Normal) FL—R, &7 7 A4 a U ERIT. FRT—FORMViAR L & HITHEIEINE

T

~ v 7 AR—/L K (Maxhold)
RT7—Z BB S ET,
=< LA —/L K (Min hold)
INT = 2 ERBRRE S E T,
Tsl—2 (Average) b L—R, HHEIOT VA PY g ilblio T/ =k L= ADT 4D

PEMEE R L Ed, ZANBERITOR OB FME T, 45 2RI L Y Fon /A XN
3dB I L £7,

FL—R, /==L NL—ZXADEERIOT 7 4V ailblco T

Fo—R, /==L« NL—RADOEEBIOT 7 A4V a U 1lblz> T
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Ny liE, WE, JE, BERORESCY — K7 U Memd UAaREOT A 2T, Ny Urffiskar
T4 —vay s Ama—lbTIEOT 7 EATEET, Ny POy A 7L, Froxn
(Channel) . 7% (Waveform) . #I%E (Measurement) . #%%% (Search). A7 L (System) 238V £,

FX RN e Ry D LER NNy Y

Fr o Ny U EER Ay Y (HE (Math), ZE¥E (Ref), /SR (Bus)) 1L, A7 UV —VAETORE
(Settings) N—IZFEKRINFE T, WRITIZENZENEAEO NNy URHV £3, TbD/Ny VITiE, £
SNTWNDLET X U RNVETITERONAA LNV ORENFERSINET, Ny PE2RZ v TT5E, %
DALy T4 T —gy s A= a—RNlEEET,

1497-013

RADF ¢ /v (Channel) 73w ¥ & (Waveform) /3 PIZIETEE A /7 —/L (Scale) R& 35V |
Ny P ANEE yTTHL ORI UPEIRENET, TNHDORY o Z2ffioT, TOEIEOREE A 7
—VEREEERSED LN TEET,

FX RN Ny DEENy DNET A AT VA DOTHNZRT TR v 7507 ) v 752 THT
WZCTEET, WD PN EICE TRAUAS TRy 7352 LT, BliE-> THELTLESGEICER
SHDHZENTEET,

Fx I Ny DET ¥ RV DOFFIRICHEOET, FEHICOWTIX, Ny PE2EZ L Tarr
4T b—=vay s Ama—%H<, ST ERERELTIEIN,
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BB/

Result (R &) Ny DIFFERAA—IZHV £, 250NNy DITTHEHRCREB/ RN RSN E T, X
P DHEA BT HRE Y —AF LY —ARFREINET, JEN Y VEBINT 5121, JlE
(Measure) A& &%~ 7 L CEBM (Add) 18R L £,

HMERY PE2EZ Yy LTEDIL T4 S —ay - A=a—kE . BENSOEEF - 1357
EITVWET,
—ERDORERLFED Ny DiE, A7V a VHEARCOARFIATEE T, 22X PWR AT v a A A

F—L ENTWAEAIZOL, FHNIEZ BN (Add Measurement) A = = —Z/%U —IEDEH NFER S
nEJ,

EBIDRE N PITHEE) — T 0 R ZBNd 512k, MEASy PE2EZy 7L TCar7 7 L—s
v A== —%Bi X, Show Statistics in Badge (FiFtfE% /Nv JICHER) ZBIRL T,

Meas 1

WENY T 4 ATV AOEMNCAT TR v 7 EZ7 Y v 735 LHIBRTEET, HUNA6 AT
ATTHENRYVERTZENTEET,
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PR DO EERE

BRENY Y

ﬁ%(%mm,ﬂ//%ﬁﬁ®ﬂ~_uﬁbfkb HIE (Measurement) Nv PO FICFERENET, M
RNy DI, BIEDT 7 A4 Vv a Y ORBY — A MREBEX A T WEEA X2 NOREMFRRFERINE
7 %ﬁi%ﬂ%@%m/%#%ibt SHTOW 2 ~—27 L, WO EEIC/NS 2 = A& £
LET, BN DE2EZ v L TEDaL T4l b—vgy s Ama—%HE MEREDEEE-
ISR 2TV E T,

Search

MBSy PaEVERRT D121 Search (FadR) RE 2 Z v LEd, Ford&hi—ar 74 7L — g0 « A
—a—%FH L CHRBREELRTLET,

Ny DITidc (RB) &> (fElr) oFErF—Tay - REZVBHY ., ZNbE#ES L Zoom (X—2L)
T— FRRE, WL a—F D Kb ~—7 & i) ~— 7 ONETHENT 4 A7 LA OffcH
RENFET, MBAY DT EHF—Tay - RENT, TIA DY a rPEILFICORMEHATX T,

Search

BN CET A AT LAOHEMCENTCRI v £33 7Y v 735 LHIBRTE ST, FHn6 AT
ATSTDHENYTERTZ &mT%i¢

BEI7Y U T LEERyY

70y B REAET D L IREICEET D HE ORI N AIEMIC Y £9, SHIZ, RIFLEREY 7
A VOIRIRE S RIEFEIZ 22 0 97, HERIERZ U oy B 7 STV 556, £ OBERIZORIERIEC
TEEEG X EEA

H
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B . o — T T T DB E T 1L R IR BEIZ T o T AR, KD I E GEI R K FE R S
B DICTEERIR o — /L RIE ST TR WEEEIZIE, 2V o B IR L F S, Trn—TF 27D
HEIENE, FN—X DB, 77— TR OWEE IE S BB S D F T

TEEHIYI 2 Y o B TIRBEIZ RS & KD T ¥ 2 F « Ny DI OB~ — 2 F o BT
(Clipping) DX FRERINET, T+ FAMNZEEDIT A SHNEN > A2, 2V E TR
SAET,

Z2Y T DA =28 USICIE, BIEEEP IR EINE L I ICHEEWERLE L, HE/LE Y —RD
57 n =T F TERIHN L, #LT7—=TE L TELVGEE 77— 2L TOE0E
Z/ i?L‘D

TT— e Ao—Tl RNy

AEETIE, =T —DBRET AL, Fr o Rl - Ry JICEBELRT ARO VAL LT — - A vk —
v (MEFE) DFERINFET,

a Temper...
i lnout Ov...

Ny VDA —VEHETLHITE, =7 —2HLET,
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Mg DO ZE

VAT A e Ny

BRIEN—IZH D System (VAT L) /Ny VA S L Horizontal (K i) . Trigger (~ U 4). Acquisition (77
ATV ay) OFERELFRTEET, System (VAT L) Ny VIIHETEEEA,

Horizontal rigger Acquisition

AT L (System) Ny TE2EZ T TLHE, FOAryT 4 =gy A= a—0REET,

s (Horizontal) /S It A4 —/L (Scale) RZUBNHY Ny PHAEZ v T HEZDORE N
FoRENFE T, KA —/L (Horizontal Scale) A& %Al H & AKERFFHRER div 2T £,
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HFFARNwT T

T vayv

FER

il

B

A7y 72« 2 hr—/1
(A4 — (Scale), T 7 —
v =z > (Navigation) )

VAEID S

Ny VOERTEILT 7|8AT
XpHarI4lL— g

A=a—

CHANNEL 1

ZyF LTH
—/L K

ENRHY £,

1\ %y P TA=a—% 57
Uy L, @EolEcT 7
vALES, BT 7>
arye LT, Ty Lo
F 7, PERKE Ny T D

MDO32 35 J O MDO34 R DR & & ZeMEIC T o~ =27 /b

29



Mees DO ZER

AT 4 T —vay e Ama—
AV T4 =gy s Am o=, FY L RADRT A—HF AT KERE (Horizontal (K i)
Trigger (N U ). Acquision (727 A ar)), WE, A—YVDOU—=KT7 DU EEE2— LT
FRSRETEET,
HEH Ny Y, B¥Ea—, I—YNLVDY—=R7 U Nel) 22RIZ T T5L, £0ar7 47—
3V Ama—PREET, &AL BE (Setttings) N—DF v R Ry VE 22X v TTDH L
TDOF v HZNDAL T 4T =gy s A= a—NHEET,

CHANNEL 1

2.00 V/div

HIROCAN LTAEITEBICKMINET, A= —ONEITEIN T, BINNEOMEE ST > 3 v, B S
nr-ru—7ofEICEbhbETEbY £,

BT 2REIL [RF2] TIA—TRTENTHWET, XN LEX v T T ERENBNERINTE
T, RNFNABREEEFETDHE, TONRFNEMORFNVCERREINTWVBHELT 4 — /L RNEFINDG
ANRHY £,
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P& ER D FER

CHANNEL 1

VERTICAL SETTINGS )

PROBE SETUP

Probe Type: TPP1000
Serial Number: CUOOD86
Version: v0.03
Attenuation: 10 X
Propagation Delay: 530 n s

Compensate
Probe

OTHER )

a7 4T —vary s A a—0NOEEOH G EF Yy T L TIDA=2—%ALET,

arv 74 b—vary s A=a—0OHep (~VY) ONFERLICIE. ZOA=a2—0h EBIcH L7 =
AF gy w—DTAariEH T LET,

R—=h e a—H « f U HFT 2 —RAER
Zoom Y — /L EMEH L CEEEZILR L, BEOMESEERLET,

200 Vidiv || 5.00 v Bl Freq: 100.00 kHz
P » 500 mpp
16 16He mtlw

1497-015
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=111

R0

1. Zoom Overview (X— AABED) 11X SR NFERIN T,

7% : Zoom Overview (X'—AMHH]) DOWTF fTOEYL P = AT ¥ RWAD D= XF ¥ &9°5 &, KV
JIN—RFEFLETE E T,

2. ZoomBox (X—Li « AR 7 R) I1Zi%, ZoomView (R—LA « B =2—) ZF#/~9 5 Zoom Overview (R— A
D) OEENAERINET (4220, Fyv 7 AZX v T LTRT v 7 3UIE0OEEE B2 —I|Z
BEITExET,

7E : ZoomBox (X'—4 « w2 X) DRBEBC(EEEFETL TH, K PN —RZEITTED Y F
H A,

3. WEra—of EBICHD Zoom (X—2L) « TA a2 T, RA—h«F—RKOA L 47280z 5
T LMTEET,

4. ZoomView (X—2A « B =—) |T1F, ZoomBox (X—4 «+ Ry 7 R) 12XV ~w—27 SLTWAIERIEE
DFEREINET, A=A - Ea—TEUVIFRRT v IOFT v a U afH LT, IERE izt
EETECTEET,

£ ZoomView (X —4 « E'z—) TEXF, LA, P70 27D XF 295, I —ALARE
& ZoomBox (X'—4 « K2 X) DOffEDHEELTEET,

5. ZoomTitleBar (X—2X « Z A FL+ N—) Oay ha—L&FH L TX—LBIBOMEDOY A XL
EPEELET, +FRE—AREX o E2 7V v FREX T T L0, FRITABIOBORH 7 &2ME
ALET, X=2 DA —VBIOMIEDO T (—/V FE22EZ v T L, ZTNVE vy THExF—/3y K
ZEMLT, MEx AN LET,

2 HWHDEZEH L TR —2L 77559 3 57/Z, Zoom Position (X*— (/&) F/=/3 Horizontal Zoom
Scale KPR —L4 « X—) X0 FLET,

—WRE AT HETF «c RAF V=V o f VBT =—REfEHRH

A—h e T RFAT Ly FOLIBRIEHER R H T « A7 V=2 T varaEALT, TEAE
DAG N =2 e A T2 VDA ETIT 4 TIHREMEEFEBLES, UDA U X2T7 7T 4 7THIEICIT
VUAREMEH) L TEET, vV ARMERZENTENRO X v FEEICHY LET,

FEARB 2 2 FRAEOM LB O TIE, REZRLTIZE0,

B3~ F v TFRI Y= U FRY (w7 RER2HER)

B R B2yFRZYV—V U TDTIY | STURATODT I gy
g v
F X, HERE, V77V BT v Rk RY FETL | BT v L RK U FETEIT
VAW ETIT N R IE A A 7 U | Add Math Ref Bus (7%, JL¥EfiE, | Add Math Ref Bus (%, FEVE(E.

— B E9, IR2EEBIMN) OREZ LU EHZ T U | NAEEBN) ORZHT U v
THE. V77 Lr A, 38 LCEE, U7y Lr 2, 720
A ZTEIR L E7, NAZFRLET,

Frxrxh, WEER, V770 | Fxr - NP FEAYy Y | Fr R Ny BTy Y
VAR ETNINAWIE BN | TN KV a2 T UE | ERITEEANC RAVE Y v o7 L
THMELET, R F9
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B DA

T

ZART

EoFRIZY—UTOT I
a v

TIARATCDT I gy

NoY (R, B, B, KE
W) IR —L s R UFEFITF
=gy RA U EFRLE
7,

Ny VBT LET,

NyPar V7 LET,

HH (bbb Ny, Ba—,
H—=INDY— KT~ F~YL
RE) a4 L—3g .
A=a—%R<,

Ny P, Ba—Fkiizomor
Ty NE2EZ T LET,

NP Ba—Fidxzofho4
T2 e X TN v LE
j—O

FI7 Vw7 A=ma— (RNyP, v
2—) HREET,

Ny EEEa2— oy b -
Ea—Fmixtzotozrs ) —v
HHAEZX vTF L, A==2—N0F<
FTAR—/LRLET,

F7V=0 baekEs ) v LE
—g‘O

a7 44— gy A= a—2
L5,

A=ma—FIHA T r T OND
TEOW 2 v 7T LET,

A=ma—FIHA T r T OND
B 7V v 7 LET,

Ama—zBEISED,

Ama—DHA RV N—F 2L
A= a—DZEAFERE X v TF LT
R—=L KL, Hl72 @A ==
—% 77 LET,

XA MVETITZEAEEE ~ T A
DERF T Vw7 LTHR—IL
KLU, il R7 v 7 LE
KR

TR F 72 1T TR B 2
B L CHEEAETELET,
WEEEIOLFITRIN L 72T v > %
NVEFITEEORIZHEA S, K
PO EE [T 2T ¥ o R &2
AN ) Ry A= B

Ny Pk H w7 LT Scale (Ar—
W) RECEFERHLET, B LL<
X, EVFHERY = AF v —%ff
HALET,

T RN Ry Y PRy Y
F 72 13K 8l (Horizontal) /3w ¥ %
70y 7 L, A—/b (Scale) R
Eoar )y LET,

R — ME A YRR E 721 3ME N L F
4 (Zoom (RX—21) F— FE)

W 2—% 2 KDOfETH vF L
TAHA—IRL, ZN5EFEFCE
BEED0, ERIFEEF DK
SEHENCEEBEL, A7 U—2D
HHIFR L E3, —HOBEELZ#:Y
WL TLEEN,

R— e U T %77 LTHK
Zv 7 LET,

A —2 (Zoom) XA RjL e« X—D
+REZELIT—ARE L E T
7 LET,

(R=2L+ B— FIFZ) X—Lf0E
EHELET,

R VT HHFERNT T
LT, A—LDNEEZHELET,

A=A VT %7V v I&KT v
JL T, A—LDONEZHEL £
7,

B Z2TIEe A7 n—/vEit
Ry LET,

HMROWHE X v TF L TCRT v T
L\i‘é—(}

MEOWIENT A &2 U w7 L
TRIv 7 LET,

FEBEAN—ZA T T, £33V T,
B o —fHk A yE KT 5,

BRA— - VR, FTRE
o — RN OB R DT
BEONBEEZ X v 7 LET,

BRA— NV, FTER
Fa— R ANA—DoEROT
BofEE 7Y v 7 LET,
FER (Results) /S—DF 34 &0
Vo Z LTRIZ v 7 LET,

T FRCOBPEN Y PORB ARy VRS —var - REVERRLTND LR £ A,
I —HoXATRT Ry 7 AL AT I DOK, Close (IL2) E/iF2ooRy 227 v/ 35ETHLERA,
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AHE DR E

HERF DR RE

RAELTZT 7 A WVITIE LW HIFHERD~— 27 S5 KO HA LR Z250E L £,

1. MiEA FiZH 5 DatelTime (HEE) Ny P& 2EF v L Carr 47 b—vay - A=ma—%B&E
7,

DATE AND TIME

2019
=

2. i EOHRFEZIERRITT DITIE, Display (FR) A¥ %247 LTOff (A7) IZLET,
AREZ R OERRT DI, BNy URFRRIN TV OZEHOT Y T & 2R% v 7 L TCar >y
47— ary - A=a—%BE, Display (£/R) R %0n () ITLET,

3. Year (4F), Day (Hf¥). Hour (F¢%4l). Minute (57). F7-i1% UTCOffset (UTC A7t~ ~) O7 1 —/b
KEsy 7 LT 7T7 44—V REIELWREINICHRET A2 b T FET,
T4 RE2EZ v 7L THFFX— Ny REfH LA Z#%ET S22 b TEET,

4. Month () X% v 7L TURINBIEEDHZRIRLET,

5, A=ma—DOHNDOEEOEH N EX v T L TA=a—%HALET,
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AHE DR E

B 77— z2TDEya—RBIORA, VAR F—)L

WD T 7 =L =T A A M=% L FIATRER i ORIE R JOFRNT O UGE S~ THMEER IR
DY FEF,
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BHESE  Hm LOBEE 7 7 AL (WE. A7V —r « Xy P F v, Fon2a—70ORERY) T4
FTUSB RIA T EITxy hV—ZIEFELTBWVWTLEI Y, AV A =D 7 avATiE, a—F
PMERL U727 7 A VIFHIBRSERAN, HER T 7 A I OWTUIEHENI AN v 7 T v T E2{T->TL T2
éb\o

USB Fo A4 7TREDA B Ra—F « 77— AT 7 DEH

AR 3, AV A=A VARV ENTWNWDE 77— T 2T DHFEDONN—T g U EHERL
TEBWTLZEW (Help (~vF) >About (HEEE)),

> 0 bd =

L

PC CWeb 77 % L#h L T, www.tek.com/product-support (27 7 & A L E7,
BRBE7 4=V Rzt RAa—TORAEZ AL TG #27 V v 7 LET,
Ay Y —vhETF~AZra—/)LL, Software (VY7 ~ox7T) X7 %7 Uy LET,

BHSHTOWDOAFAERY 7 =40 =7 « N=Ua VB, BENOFTRAI=TFDLD LY b
LWEBIZIE, 207 7 ANV EFEIRLTPCIZH Y rm— RL TSN,

T7—LUxzT A A=) T7ANVEUSB K74 7I2at—LET,
USB R A4 724> a2a—7DOUSBARA b « R— MIEALET,
FvuRXRa—7OEREYY ., 0%, Frvaxa—7OEREANET,

HE: Tr7r—A0 2T DL RP—IPBETTEETIL, ForRa—D&EReE0>/7=0, USB 7~
vz e NS TERDINLED LRNWTSES N, FonXa—D& e8> Tl IF 456
HEX =B o r X a— NS AET,

FiuRAa—Fn, Tr—bUxT c T ANNDBREFEINTNDUSB KIA4 72 BELTA VA F—
MR ZBB L ET, BEOERCE-TC I 77— =T A A M= LET,

T7 =AU zT DAL AM=ANET LIZL, USB RTIATEZWMVAL, v Aa—72EEE L
F7,
T7 =AU xTNIELLA VAN EINTZIEE2MHERTIHIZIE, Aoa— - N—0b

a. Help (~V7) >About (=) 2% 7L %7,

b. HEICETREINTWVWAE T 7 —L T T « N=Ug VB EN, Fura— KL=V g 00k
LRI THAZ L ZMERLET,
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AHEDORE

B 5 IE (SPC) DFEAT

mOERS L 2 R+ 5 72 OIZEWIANIZ SPC 23T L T 72 &V, JAPH (EA) iE2 5C (9°F) LLEA
L LT E 1303 SPC #3447 L T 12 &V, £72, 5mVidiv BL T O FEERE A 7 — VERGE 214 55618
b, WIC—E, SPCAFEITL TSIV,

EERIEHE (SPC) 1Z. AFEIREOEIRCEM FY 7 Mo X - THEUARTERRIKO DC L UL DR
DOFELIEIELE T, SPC #EMMNZEIT L2WEE KW Vdv RETHRIESNTWAE A e A a—7
BEEELNRVATREERDH Y £,

AR SRAT - 43, BE SRV DTF v XNV AN E Y T RRNVDIE AR T a—T7 L r—7 &
NTHYALTLESNY,

1. Fiuz2a—70EREZF AL, 05 ET+—0 « 7P LET,
2. Utility (==—5 ¢ U 1) >Calibration (IKIE) #% v 7L %7,

3. RunSPC (SPC »3FEfT) # % v 7L £, SPC ®»FEITH X, SPC Status (SPC A5 —#% ) DY — KT
7 MZ Running (E17H) LFERENET, 1 F v R HT20 D SPC DEITITIIE N DHENH
5728, SPCAT—HAD A vE—T M Pass (BA4%) ICEDDLE TR TG, Fa—7 & {6 L
THYRAI—=T%2EHTHEIIICLTIEEN,

4. SPC 35271 L7256 Calibration (IX1E) 27427 v —ay - A4 7720 ET,

5. SPCIZKMLTBAICITIT T — - A=V« TFRAPEZEIFOTBVTILEE Y, Tu—7¢7
— TN T XTI EINTNWDEZ E2MERL, SPCAEH D —EFRITLET, T TH SPCITHEL
7=5AIE, Yt A X2~ - AR — MIBEIWEHDE T &N,

TPP0250 %Y. TPP0500B %!, = 7=1% TPP1000 B>~ 1 — 7 DHHIE

TR Y AT & SRS EE OMIE 2 R T 272012, e —THIEIC K Y 7r — 7 0 s RNE &
LET, A+ maa—7CiE, TPP0250 L, TPPO500B %!, F5 & OF TPP1000 o> 7' m1 — 7 (2 5k 9 % A IEfi
DB L RIFZ HB CHEITTE X,

KA mAra—FTlL, FTue—7LF v RLOMLEDLE T EICHEEMEMES N, P u—7 % Bk
9% & HE CHEMEARFONM S EJ, Channel (Fx > x/L) a7 47 Lb—3 9« A==—0 Probe
Setup (Fu—7 kv hT v7) RNPFUE, T —TWIEAT—X ANFREINET,

= Probe Compensation Status (7' — 7 #iiIEA T —X &) 7 4 —/L RIZ Pass (G4%) LFR RSN TWDHY
A, TOTE—TIIIES TR Y ERATRE/RETT,

= Probe Compensation Status (7= —7H#iiEA T —4% ZX) 7 ¢ —/L RiZ Default (77 +/L ) EERRINT
WAHEGAE, BRI a—T 3 EEMESRTWARWEY, 2o a—T7HIEFIEEZ T L0
N0 FET,

= Probe Compensation Status (7' 71— 7 HHIE AT —4& Z) 7 (—/L RIZ Fail (R&Hs) LFRENTWDHE
G Bt e =T~ e —TMIERIEN KL TCWET, Z207e—T7%28HELELT, b
) —ETO—THIEEEITL TSN,

B ARV —=THIEARAT —HZ R « 74— )L FRFRINTOWRWEAIT., 204y 2Aa—7TCik
FOTu—T OMEEERGFETEE A, KA B ZT—TDHelp (~VF) v, Fo—7HiEk
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WiFFERIR : N ER T, BILOCHNER BIEIFEIT 5 R IR IR, RA R TR, S FTIT
HLSELAATHEE,

WA BRI/ NOERIE « AR TR A EER BE A BB, TEE) TORP AR, BEATIRB ROz,
BEWOFRIE, ET R EA) RN Sk,

fERWIEREM . BHUEEER EHREEESM T B/ Bl e,

FMHRIRTE

ARTFErh A e I BLX LLKE

2 B - B A FTRER N G B R A i L BRI g AR,

2 TERL » “TLE AT ] P REXT AT i B H A T = 22 AR AR Y e 2 A

=i ERIRIE
i BT RE X L ARAE
= DANGER (ff&) HSEHZRIZIRICE o] EH2S BN S EMfERR,
= WARNING (#45) RREFERNZAREN A EES BN S HENAGR,
= CAUTION (VEE) o aTREEXS AT St mi Hofth o 7= 5 R AU B

5 RO

c P ERRORICRE SR, EIAORER T, DL TR B A S B LA Kk G IX L £ B 7 SR XA REAE
(HFF 53 fTREH THE 51 P 2R F M i8UEERE E.)

P BT MU R 5

A @ 4yt

B RIPIEG A gy TDEE
E&F M EitinF

o
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D L. —-,

1=
A TGRS R —SRPEE B, B 7 S B e 7 BRI ABUR I, PEIERIRME, A
SRMIEE, EHEPE LI,
TEIhRE
SN i] 3 551 MDO, 3 51 MDO 77155 (MDOB2 i MDO4) & 2 St 4 it 7+l 2, AER 857 i it
R AR,

THOOFRSE AGEE, AT &

= T3 100 MHz = 1 GHz

o FTEHEON &Y 2 WiE 4

= 16 EEHCTE AR

w KII16 s (1920 x 1080 14:58) EBAEMMELE /Rt
= EEXARERAE LR P S

m TAREERLEE B R R 25 GS/s (3t THF 1 GHz 3% #4:1%) MDO34 5% MDO32, 7£ 1 ik 2 /NiiE 3 5GS/
s)

= FTAEE ERIEFARES N 10M A
w EOKIEJERER A 5] FastAcq B : 280,000 NETEIFD 5 1EH TAFERY >50,000 IR

s ERAREFISHT - 12C, SPI. USB2.0. CAN, CANFD. LIN, FlexRay. RS-232. RS-422, RS-485. UART,
128, Z=XI5F (L)), AXF5F (RJ). TDM,. MIL-STD-1553, ARINC429 (FASEIEM:) FitaT

n DIERGHT (AE)
n  AEEHEKR A6 MmE (FTik)
w A VEM S BR IR 5L BB R AR L AR TR T R

MDO32, MDO34 223 Fn 224+t vii
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o

puni|

RS ICHY

viii

TR FR S SORY T R AR DR B 215 8.

BOR LUK FAMATSS
MDO34, MDO32 3C#%4

A E R R B A A TR AR, BT AT RE HH I R

ETHEMEER 155 P L SCRY

qofrft A 2R EhRE 3 %%IMDO (MDO34, MD0O32) ZZi&fnzzeF M (ASCkY, Z&7ail 4% = 071-3608-
xx) ; AERFRECHHE, TS, B SCRfE AT SCE S RO SORY,
3 SALYMDO 758y (EsHEBh I AT ¥ TRIRRAS, ANERFRBa & T A s ThEER | F 3¢
FEIHBH ;AT www.tek.com/downloads 3k Hi)

AT I AR R I 28 3 F5IMDO /7R FH (FRaEREYR = 077-1498-xx ; AJ M www.tek.com/downloads 3k
i)

B RIS DL BBIEA | 3 F5IMDO (MDO34, MDO32) KRB FIlERER UEFEAR S E (Fva iR =

T A R B I

s

077-1499-xx ; BT M www.tek.com/downloads X Hi)

A TR, R gERR

3 AZMDO (MDO34, MDO32) #/5FH (Feyiahbit-4ms 077-1500-xx ; A M

HRENFD AT SRR www.tek.com/downloads 3K Ht)
TEHLLR Fp 2235 25 RM3 #lZ8x73EE1F i B (ZeT7EE 4R 5 071-3609-xx ; AJ M www.tek.com/downloads 3k

IR
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A

B &R

R CIAEIPT AT I8, WERAEATER S, EBCRRITE PSR, fEALEMX, 1E3K+T 1-800-833-9200,
Hoft s X P 18 15 8] www.tek.com B4 2 HEFYBR SR 15 B,

ERE XM REM ST 8, LU IAR A eI BT A PR LR AT 1 dh, WRAEIASR T )ik fF, & it Help

(FBBh) >About (32F) LIAIAIE(}:E.7F Installed Options (EL7Z24E1E (4
FRECRHE:

) EHFIH,

mH & R RS
3 %5/MDO (MDO34, MD032) ZiEfiZ+FH 1 071-3608-xx
TIREBELRK, Bk TS fRSepEoEE — 1 | TPP1000

(1GHz F ) TPP0500B

(350 MHz %1 500 MHz) TPP0250B

(100 MHz #n 200 MHz & 3%)
PRl 1 016-2144-xx
=R/t 4 1 Hok - Xigk
FEUEIE P 1 AE M
OpenChoice® s &4 (] M www.tek.com/software/downloads ., )

TR T

A\

MDO32.

TE e A B 18 SR LERA R AR Lk S B T sl IR AR 2 BB 4R

ER : EIEETFH L IE R R LA T, IE0HE T TS, X i RELR BB FHIFIBLAE

1B F75,

LR ETEF G UG E AR, B OIEFE T, LIGIRT B4,

Lk

MDO34 n

R
e
<+H
=

344008




BAEER
ERIEREIRE ., BIR. e S B4 A B E 0B ER R gy, DABR A amn i & - AR AN 25 1
EZ 4,
IREELK
ek %A
T AR -10°C = +55°C (+14°F = +131%)
R BOR, B A EAEMNEE AN AT E 2 2551 (51 mm) LB N HE )
TARRE TEANTE T +40 °C (+104 °F) B, ARFTIREE R 5% %1 90% (% RH), LI EE,
1E +40°C & +55°C  (+104 °F = +131%7) B, FAXTEE R 5% = 60%, ToH
¥£L%O
TAEHER & B 3,000 3K (9,842 HER)
BB YR ER
s %A
BB E 100V - 240 Vpocruss £10%, L-WiE|
BB AT =R 50/60 Hz, 100-240V
100 % 132V B9 400 Hz + 10%
5 BA130W
PN ER= P
FHE A B EHIE I IREVER PN, DA R ERS i rO M B 0B 1R 3R ARl sl 5 e Sk sl AR 25
TR AME 5% DL T R,
Fz 1 B A
WA i EA
PR A GEE, 1MQi&E, BNC EAYE K| 300 VRys
W A\BE

TS H 1
£ 4.5 MHz 11 45 MHz -2 [E)8UE B L 20 dB/E9IFE % ; 7F 45 MHz
1450 MHz .2 [RIERE (BT 14 db TNF%, & T 450 MHz B 5 Veyso

BLL A HIE, 50 Qi&E, BNC LAUEK |5V Rys, WHEAEF £20V, (DF <6.25%),

MABE
RF % A\ fc K A B E EHIHEELE TS - +20 dBm (0.1 W)

BRIFHIRRIELIR © 40 VDC

BRI +33 dBm (2 W) CW

WE{B kI Zh =R : +45 dBm (32 W)

BRI 2R E LA« KEE <10ps, 522k <1% HEBB 8 2
+10 dBm

2 MDO32, MDO34 Zed:Fnze 4Tt



7 2: 5 P6316 $x Rk KA

\mA B

HEREE +(100 mV + B HE 5 BB IR & 1) 3%)
BB +25V E 15V

R R R A G 5 +30V E 20V

FoME S 1ERIR 500 mV i

BB H 101 kQ

MABRK 8.0 pF (BL77I{H)

5 YL 2R, REANMLA

B 5% 2= 95% FH X i

fafoRBi a2 CRrEBIE)

PR I A BUE BN TG SR B LA LR R 7= 1 2,

FHREEIE A BN 2 B R IR [ AR,  DUERPREEEE S TG, HI2RSHMALE,

100-240 V
50/60 Hz

115V, 400 Hz Kee-

130 W Max [E REM-
tek-

osc

A ER) @

LAN 10/100

Patents associated with this product,
if any, can be found at:
www.patentlabel.com/tektronix

AFG Out AUX Out

LXi
D

USB 2.0
Device

MDO32, MDO34 Z23tEFn 224+t

S

USB 2.0
Host

Mfr. Compliance Contact
Tektronix, Inc.

PO Box 500, MS 19-045
Beaverton, OR 97077, USA
www.tek.com

HDMI

B = e

3608-003




\ B0

LA

B B e ER
S AP BRI R S P EI T EBERIR, AREFI PSR R a, 18 AR LR A AN 3R B A BR R S R B 12
B 52 B,
ATFESRA « o 7RI B Y A2 it ER 4R
1. R O BR R L ORI AR R IR 1 25,

[

1

)

0 Qg

00 o

0ooo
00000

18O

Il> 0o O Of

[ =
PR =
i g

3608-001

1: BJRER BB BIRAHLIT R

2. CRFERRERS A AT B IR BRI,

15 ORF A BB R L T ) T BB (I B BRI AR TSRS, R N BRI L B kAl fiL BB,
3. & A AR R IR F T Ao AL BB,

BB AR AR BIRES -

5T - RIB AR B

A - FRHLEA

Bt-CiEs
4. ZE UMW ERIE, BT BIEE,
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PR AR EE AL E

TEAL B A AT AR IR A BRI T LS JE 5 I A,

1.
2.
3.

FTH R I o B 4 3 R i 25 5
TGS B %42 Utility (WEBHTHAE) > Self Test (HAQ) KT Self Test (H#A) FlfELE#,
AL B R AR R Passed (GET),

MR R R ITALE B E T Failed (M) :

a. HEHPEERILARERE,

b. i Utility (REBhTHEE) > Self Test (H#), MR —KEZRIFHLERYE ~KBE, BHRARTE
P ERERI,

EERPRk

PRI BB SR I s E BB (RN R & (DUT), Al RERB 5 A DERC AR 75T B BRI RS,

1.

MDO32, MDO34 Z23tEFn 224+t

3608-002

2. [ERAERMNSR

2 v i JHP PR K HE 1 (TekVPI)

XS PR SRRE T PR B R AR T EEE, I REE I AT YR FR SR R I A AR A T O A AE
TEMERERERA SN (0 ATE) h, mREZESI+5A .

N=oPAN

IXUEPRCHENIAE TekVPI 42 1 DhRER AR .~ b, AN PREEIIILA HAR BRI R d i, LA RS E
SRS, XIS AC HME,

TPA-BNC & il



TPA-BNC 3 fic i f0.1F 5 1 TekProbe || PRk ZhE, Gilnafesk it e Ll KR BEAE BN AT 4R LA 7R 4.
4. BNC 1

A 45 f ] TEKPROBE ZhEEIHIE TAAG S A EEAR AR o, AUqRUEIR(E 5, AR THAIEIE,
5. BELEN

P6316 PRKHE(IL 16 MMEEHdE (B 150) (58,
6. TPA-N-VPI & HC 27 BEIETE S S0 8 A Hh 55 ) TekVPI 3K,

5 TPP0250, TPP0500B, TPP1000. TekVPI+, TekVP! B Hofth 37 A0 28 suAR b e Sk HE N S A SEBERR B T B2,
SKEABINE, FRTEIM MRS, RKEHOEASUFEIE,

TekVPI F3k B 3D EZPRAAEERM A S (BB, R, MWfi), ARESKTE Menu GER) 104, %
TR T FIIFbE A RACE SR, B IRA TR R IRES S (A3, M),

15 BNC PR3k sl B HE AJiiE BNC | 1 EEREERIFHERE, A5, BB e 8T 268 H 81K,

HHSER T 3 RS MDO /Rl gn e ZHEsk iR 415 B, BRI Z8 LMk (www.tektronix.com) ) Oscilloscope
Probe and Accessory Selector Tool (7R g Sk FIFfH IR R T2,

*

TER . BRI A AN (BOE) Blil, (/R FEF2em 1% 5 B T L 2 LA
U LIRX S BHRE (FE, R, TmtZ5),

M =
PUZRZIEE R
FTHEAG RM3 HLAR A AP T IERR AR B WU P 24 m e e, BRI TS A B 5 (BU) e,

TEBR R AR T P SRR T DA e L 2R 2 A e 1 RM3, BB LR 2SS RN B (RM3 #12e 436
PFIE g, ZRyiEsit-4m 5 071-3609-xx) ,

S5 WA 1B PR ST 22 B DU RE T, 1 S L B R T 22 B LSRR T A BB SR f b b,

M Web 33 ¥ #51Z 72 14 7]
AT LA Web 530 S8 g3z B2 1 8 Bk D S s LUEAE PC RS qEs A P i,
I RS 4B An TS T B S ) UL P2 B
ATFESRIE -
AR L AUERE PC IHERAI N BT ZMBRATIEE, BES0 FLME (LAN)F34 T

o PAEEHE ARG 1P #ibl, BERE RIS 1P #ikl, BRI AR R IR R BN ThRE > 10, &
J&, 7 LAN ER P EE W& E,

1. TEG R F — M EE R PC LT Web X 545,

2. AFEENELN URL T8 AR SS IP Hikt, J4% T Enter ([21ZE), 40 : 135.62.88.157, ¥l SE a4 21
FIIF RIS IR,

6 MDO32, MDO34 ZedsFnze 4Tt



{7 USB BRI R IL SRRE B2 PC

i —HR USB BBER B B I 2 B HEE] PC LIEFRPEMIA

1. TR B, MEREGIZEHEBIZhEE > 110,

2, N USBiRZBIM,

3. I USB & & i O HEHI R (BRIARE) .

4. fF5 PC FHIEM) USB HBLERIE HAX AR a0 USB & & it [,

5. AnfE A USB EHEEIT GPIB dy S im Rl i ar, B IR LK & 1% & GPIB @i M Hukk (0 - 30),

it SR BR A FARAT I DR R B AN, AR AAEATS5 G, T BRAT 2lohin S5 75% 1Y 5 N N RS a8, (8]
FREETH B P NI £ 2R B p e 228, B 20 A rTREIR IR ARISERE, Sh52, HfF. PRICEARE S FlhE
BRI ARTE BRI S L dh.
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L ESIES

LUT N ABERAR g2 (A P S

A A IR PR S DR B M AT R AR R, BRI,

AT AR RO B2 dn

GINAE R R NER PRV ILIPS IV S IE =

i A USB R & HINLIE,

Tektronix

KV, FRERFERR, EREG R MR S BR M AG

3: 3 %1 MDO #2244

1. Acquisition (R£) F Cursors (Ot#R) #E1F :

MDO32, MDO34 Z23tEFn 224+t
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Run / Stop Single / Seq
DA B0

3514-011

= Run/Stop GBITHEIL) FHiafiiE LEOERE, HHEABG T RRERS (&6 = IEMESTTARE |
gt =EfFik), (FIER, REERFETR ERFERCRIERIIY., B LAY Run/Stop GE1T/=IE) 4

= Cursors OLHFR) 4l PTHTIFECORHERR, M ZDhRER AR B, WE AR RESORS (%)
FIIFBLE SR LIR E AR R D) 6E,

= FastAcq™ (PRERIE) nIJSMHBEE I PRECRAERG, FastAcq (PRiECRIE) fRUEmEBIZMHIRIIEE,
AR R BAISELXES B, M REB IR TN R RS S, B iRl R gk, XA TR
DUERAVE 550 POs R IRAEARE ] LU R HL R A SRR B BRI IS,

= Single/Seq (BYX/F5) FIFRICE I TERESFFELEAI R (40 Acquisition (RHE) Bl g
FT&IE) ., 2T Single/Seq (B/K/F51) #240FF5F Run/Stop GBAT/M%E1E) M= TR K RE, %
HE A T H R RIS (G APRRKE = fIRB B R RAE ; &6 = SHEFE) . BRI T
Single/Seq (BR/FH) AT H — IR R,

= HighRes (mo#ER) BUAREMHIRERITTRATA R TEE, HighRes (RofkR) Bdzt
Sy PR S ETH RBRIKAY I,

= Clear (fFR) AIAPAE I BR Y iR AR 0 BAE,
ZIhReled

] Fine
& e

3BU0

= ZIhRefEd (A, B) ZIiRElEth A fn B AT BIOUAR IF/ERC E S B f AME TR E S HE, 1R T il ]
2 OrRe el SRR R, T R I S SO AT B PR, IO e TR, &
Tl Bl AT R s,

# N2 oheehedl rlE ] Fine (B0A) #C, A FEATAMOE S, PR FiedRHEH Fine (741A)
R

YEE : AR ELZELEL RN, 4T br/5% 7/ Coarse (#118) FiFine (418) IELJ#E,

MDO32, MDO34 Z:3EFnz2 4T



3. Trigger (fit&) #5ff :

TRIGGER
Ready
Trig'd
Level

=
e
&

O

Set to 50%

va
N

Auto

Norm

3514-012

= Force (BH|) FIERIE LR ABRHI T Al &R SRR,

= Level (BB°F) WRIE(S 5 PUEE LI A ARG HERIIEZ R, Level (BBF) SE@MBC nfaR
RSt & 2 S FCAth Al R R, 24 ok R SR TSR o BB AR el FLAt kR SRGE B (M Trigger (i)
FLIERRIRIE), Level (V) FEIFHEEM, i FHEd nPRIIREB VAR E R (F SR EE VR
9 50%.

= Slope (FI=) FREMAIFRME SIS (HEEE, BEmEERdEEETm), % T R8T
PRI TSI, Y il R SRR A RLRIRERS (M Trigger (i) BLEZRIRZE), Slope (Fi)
i3 ERZ IS

= Mode (i) &EMNGEFA(ERANIAEMEFIEATA

= Auto (H3h) flERBEAMNEGERETEREE (MRRERAEMEEN), RE MR EN,

AT R RREBI . ARRR AR ST, SRR iR F A R I R R A RERIEIY,
= Normal (IE%) filk R ANFIR EMIRE LA EABIRR SR T REFMEREIY, 8%
AfEMAtE, WE RS —EER E—UCREMEIFIER, MR LUORRERY, WARE R
o

MDO32. MDO34 Ze#EfnZe 4 F Mt 11
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4,

Vertical (i) #21F :

VERTICAL

Position

L]
- B

Scale

@@@

3608-011

= Position (&) FHESFT £, FRBIPTIEREIE KA, Position ((ZE) hefAIBCFE e
FTERIROET . 5 T WHEHFEIE PR R R b LRyl

= Scale (&) FR{EFNEEIE G TEEZ LA IIEL BAL, FREEMERIZARE LE7R, Scale (A
J£) TEd B G bR R e AT RERI IO

= Channel GEiE) #Z4FTH (B77), EFSOCHEIE, W TFHIR
o WRERERIEE, 4T Channel GliE) #24 nl7E 9 9B T FZimiE,
o IREAERFEPESAREFEIE, KT iREE R E T IZIEE,
o RAERETPEOR A EETEE, K P ZEEASN O ORI E )
= Math (B%) #REAEWE B P IRINEOE R HCFER, W NEs
o WURAAFAERCTE, $T Math (B07)  $4R AT 1B 0 B R A I A R T R

B,
»  WEREZEERER B BEIY, % TR RE B B,

= WREZLEIFIERECEEOY, RS v ORI EIE CREF B S R .
PRI Tzl v BRI,

= Ref (%) W AR TINEAERE 2% (ThiF) BIF, WTFPrs

o WPERGFHESE W, 1T Ref (235) #47FTJF Browse Waveform Files (x| 38 i1 72 50 4) i
B, BB SO (fisf) IR, SJE, A Recall (EH) MBS RS EHN.

 WERRERNBEPY, # FREHE SRR S B (RN B e . ik
% Nz /T BRI,

= WREREBOWANBEWIY, HTRGE I RIRER N SEWIT.
= Bus (E&) #H7E BT ME TR0 BL&WY, R

o MERAEREE, T Bus (B HH mI{E Y B DRI B T B
%8,

o WRAESRANEEEY, TR TR B EWIE RN BB T ER)
= WCREREAWMANBL WY, T iZiGE T RIRER 5 EE Y.

= RF (530) 8l e B0 QB PSSR, T MEH U R 3550, BT A BsE 4o, 3%
SRR, (EUHREIRESE, K 2 B,

= Digital (3%7) RZET7ED T ME FRNEOERE T
n RRERETEE, T Digital (3T tRHNSEW B AT EE,

MDO32, MDO34 Z:3EFnz2 4Tt



= WRAERERE B R RMERIE T TEIE, T Digital (B0 REIRERECTIIY.
il

o RAESER EEORIRE T ECTIEIE, 2T Digital () HHERFCHETIEE  CREH N BETE R
B R o

5. Horizontal (7K3F) #5244 -

HORIZONTAL

3608-012

= Position (i) FFEIE MR BRI S —M CRFEEIPIE R T AOMA AALE) . # Fhed nrfFin
REMET A G,

= Scale (FREE) RE/RIEARAIEAN EEACTAI LR HOR B LU R RS HL, $REEE ] TRTA Y,
6. et

= Touch Off (MMFESCH) RHIASAIMASELIRE, FEMRELBRIERAT, Touch Off (Al SCH) Ml Eil,

= Save (fRf7) R—RBIR(FHERME, A A A0 File > Save As (U > BAFR) REMRFIEHER (A1
FITFSRBAIFSEME) . BOESCNE, NERES, W TFTR

= JRAE ERANERE B e 1T File > Save (3U{F: > 1) 2k File > Save As (U > 7347 R) #fE,
# T Save (fRfF) WA IKTE Save As (F31FA) BLiE S8 PIRIEAINL E PR A7 SRR,

= AR ERGESRENER R AN S RHRSE, 2T Save (PR{F) AIFTJF Save As (73/FR) HLiE
KB, B DIRTR LR BRSO (BhE, BOP%), WREEMAHESE LK R
AONLIE, SRJIES OK (TAiE) . fRERISUIFIFHIRTE, TIRILT Save (PR7F) B, fFERAFR—
AT,

= Screen Captures (H5f) [HHIRIEANFEAE, GG R AR E 38 T EHE,

= Default Setup (BRIAIR(E) nlRPRIEARIRE OKF:, ME, AR, (ZES) KERMIARE, KINR
AN 2 O P e U S B h g T H

= Autoset (HZ)IRE) oI H B RRIEAIEIE,

MDO32. MDO34 Ze#EfnZe 4 F Mt 13



7. BEMUFIZRSKAMBERES

po V & Wrist Band

Probe Tip

3608014

= PEHIFIERSKAMBIE AL TAER A T RIRTHEARI L, SEHE s (B TR/ it B
s GRS BEHER) RN, DAEE D) B (£ A Rn s PR DUT B PR BB 3R I (ESD),

o PRECIMBIEHARL N EHESSS (L rERR) 0 1kHz D7l (R irosErr), w1 T T B
PRIy SRR (PRKAME) o TR IZAE 5 B ShAME SR ERk, AR T Rk, 1B
2[5 AP TPP0250, TPP0500B 24 TPP1000 ££265533 1T,

8. USB Z:HE#N (USB20) :

=) =,
= \ﬂ[ﬂ |

3608-015

USB 2.0

= USB i D TR ACH ARG L, R ASOR s O ERER IR, %, RiERM
HWht) MUE, SUEREARSRESIIEIRE.

14 MDO32, MDO34 Z:3EFnz2 4T



w ASTUR AR HE SR IT A TekVPI+ Fi TekVPI U &Sk BNC LIRSk, P6316 BEIRKLFN BNC BB4E,
BELW ERRAF S R,

Je T AR B 12

Jo MO B2 AT R I AR HE BB IR 4R . USBIR&E . I, 255751 AFG fa A H2R,

100-240 V
50/60 Hz

115V, 400 Hz Kee
EOpY =X [E = Mfr. Compliance Contact
osc Tektronix, Inc.
Patents associated with this product, PO Box 500, MS 19-045
if any, can be found at: & X ﬂ @. @ Beaverton, OR 97077, USA
www.patentlabel.com/tektronix — c us www.tek.com

LAN 10/100 [V:pX0) USB 2.0 HDMI

%’ Device Host
-

3608-023

1. BBIRERIERISE, HBEME AR Sh % A AL E F M X IAE A B,
2. AFG Out /& AT E 5 K A= 4% (AFG) HO15 5% Hi.,

MDO32. MDO34 Z2%Efn7e 4> Tt 15



AUX Out TS fill & FF £ pRAE 75 BEBE 8o M AFG %l tH IR AHE 5

LAN 3E 225 (RJ-45) il a2 £ 10/100 Base-T ek 4.,

USB & & it 11 FH T3E82 PC, LA F USBTMC tHMSUZ F2 i R e

USB =30 11 FH T3EH2 USB INFiR &, BE SRR,

HDMI % Hi ] T IE RN B an B B SR B m /s i 2 i o

ZARBUERS T FRIE PC/2E 10 A BB I 81 BB 40 i i i [ 72 2 TAE A B H AT 1,

Eh PN

fit P P2 SR T L B R . T RS ORI (R T A 7 B i D RE O B R P 1

© N o o B~ »

Ho period fourd

1. SRRERUUIUVNEM SRR, XERIEOL
= {RAE. NERFNTAR SCHE
o IRERE AR R T E
= FCE G A
= ZITHR
w ERERM EFNIE N TT (TekSecure™)
= NEGEEE AT
= FTFEEAE

2. Waveform View (RJHE) BHLRRERL, 57, B0, B ERMBRIIY. WK AITEIL T GRRMT) .
BB BRI T 2, BB IR LR 7 SRR YT T T,

3. Results (%) ZWEETCHR, MR PIRINEGE RE LA Results (55 82) BRI Erofer:, #2
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